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UNIT - I 

WEBSITE DEVELOPMENT  

 

Learning objectives:- 

At the end of this unit the students will be able to: 

 Define a website 

 Classify different types of websites 

 Know the steps to build a website 

 Know about Domain Name Registration  

 Know about hosting of website 

 Know how to secure a website. 

STRUCTURE 

1.1 Websites Overview 

1.2 Websites Types 

1.3 Website Designing 

1.4 Websites Development 

1.5 Website Publishing 

1.6 Website URL Registration 

1.7 Website Hosting 

1.8 Website Security 

1.9 Summary  

1.10 Check your Progress 

1.11 Check your Progress- possible answer 

1.12 References 
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1.1 Website Overview 

A website is a collection of individual documents and 

files made up of text, graphics, colors, links, and 

formatting that come together to create a complete user 

experience. Websites are accessible through web 

browsers. A web browser is a computer application 

capable of downloading and displaying the files and 

components that make up a website. Popular web browsers like Google Chrome, Mozilla 

Firefox, and Safari. 

Websites and their associated HTML documents and files are stored on computers called 

web servers. Web servers must be able to receive requests from a user’s web browser and 

send the necessary files back to them to display a website. 

1.2 Website Types 

Website is a location on web and is hosted on a web server. It is a set of related web 

pages. It is accessed using Internet address known as Uniform Resource Locator.  

TYPES OF WEBSITE  

There are two type of web site: 

1. Static Websites 

Static websites are also known as flat or 

stationary websites. They are loaded on the 

client’s browser as exactly they are stored on 

the web server. Such websites contain only 

static information. User can only read the 

information but can’t do any modification or interact with the information. 

Static websites are created using only HTML. Static websites are only used when 

the information is no more required to be modified. 
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2. Dynamic Websites 

Dynamic websites shows different information at 

different point of time. It is possible to change a 

portion of a web page without loading the entire 

web page. It has been made possible 

using Ajax technology. 

 

Server-side dynamic web page 

It is created by using server-side scripting. There are server-side scripting 

parameters that determine how to assemble a new web page which also includes 

setting up of more client-side processing. 

Client-side dynamic web page 

It is processed using client side scripting such as JavaScript. And then passed in 

to Document Object Model (DOM). 

1.3 Website Designing 

Web designing has direct link to 

visual aspect of a web site. Effective 

web design is necessary to 

communicate ideas effectively. Web 

designing is subset of web 

development. However these terms 

are used interchangeably. Web 

Design Plan should include the 

following: 

 Details about information 

architecture. 

 Planned structure of site. 

 A site map of pages. 
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Wireframe 
Wireframe refers to a visual guide to appearance of web pages. It helps to define 

structure of web site, linking between web pages and layout of visual elements. 

Following things are included in a wireframe: 

• Boxes of primary graphical elements 

• Placement of headlines and sub headings 

• Simple layout structure 

• Calls to action 

• Text blocks 

Wireframe can be created using program like Visio but you can also use a pen and paper. 

Web Designing Tools 

Here is the list of tools that can be used to make effective web designs: 

S.N. Tool Description 

1. Photoshop CC 

This is a great web designing tool provided by Adobe. The latest Photoshop CC 

2014 supports many new features such as smart objects, layer comps, smart guides, 

Type kit integration, font search, and workflow enhancements. 

2. Illustrator CC 

Illustrator CC is also a web designing tool comes with powerful features like 

AutoCAD libraries, white overprint, fill and stroke proxy swap for text, automatic 

corner generation, unembed images and touch type tools etc. 

3. Sublime Text 

Sublime Text is a source code editor with Python application programming interface. 

It's functionality can be extended using plugins. 

4. Imageoptim 

It is basically used for optimizing images on a website in order to load them faster by 

finding best compression parameters and by removing unnecessary comments. 

5. Sketch 3 

Sketch 3 is a web designing tool developed specifically for designing interfaces, 

websites, icons etc. 

6. Heroku 

It is also a great web development tool which supports Ruby, Node.js, Python, java 

and PHP. 

7. Axure 

It supports prototyping, documentation, and wire framing tools for making 

interactive website design. 

8. Hype 2 

The Hype 2 offers: Easiest way to Animate & add interactivity, Hardness the power 

of HTML5, Mobile responsiveness, and WYSIWYG features. 
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9. Image Alpha 

This tool helps to reduce file sizes of 24-bit PNG files. It does so by applying lossy 

compression and converts it to PNG8+alpha format which more efficient. 

10. Hammer 

This tool is suitable for non-programmers and good only for small projects. 

11. JPEGmini Lite 

It is an image optimizing tool and supports photos in any resolution up to 28 

Megapixels. 

12. BugHerd 

This tool helps to see how the projects is going and what everyone is working on. It 

also helps to identify issues in development. 

Web Page Anatomy 

A web site includes the following components: 

1. Containing Block 

Container can be in the form of page’s body tag, an all containing div tag. Without 

container there would be no place to put the contents of a web page. 

2. Logo 

Logo refers to the identity of a website and is used across a company’s various forms 

of marketing such as business cards, letterhead, broachers and so on. 

3. Navigation 

The site’s navigation 

system should be easy to 

find and use. Often the 

navigation is placed right at 

the top of the page. 

4. Content 

The content on a web site 

should be relevant to the 

purpose of the web site. 

5. Footer 

Footer is located at the 

bottom of the page. It 

usually contains copyright, 

contract and legal information as well as few links to the main sections of the site. 

6. Whitespace 

It is also called as negative space and refers to any area of page that is not covered 

by type or illustrations. 

1.4 Website Development 

STEPS TO BUILD A WEBSITE 

Step 1: Hosting 

The first step in constructing a website is to decide about the web hosting 
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provider for your site. There are several types of Web hosting options you can 

choose from such as: 

Free Web hosts: Most people want to go for free Web hosting. On one hand it is 

free but on the other hand, you don’t always get much space, due to low 

bandwidth. 

Search a Web Hosting Provider: These are the links to other sites for finding a 

good host for your site. 

Step 2: Domain Name 

You can plan your website in two ways: using a domain name and without using 

a domain name. You can put up a site on free hosting or even paid hosting plans. 

A domain name provides extra branding for your site and makes it easier for 

people to remember the URL.  

Step 3: Plan Your Website 

After deciding the domain and your URL, you can start planning your site. You 

need to decide the audience aimed at. Select the type of site: Most websites are 

news/information, product, or reference sites. Each has a different focus. A site 

must have formal language; where as a personal site can use slang and an 

informal tone. 

Step 4: Build Your Website Page by Page 

For building a website you need to work on one page at a time. To build your site 

you should be familiar with the key elements of the site as discussed above.  

Step 5: Publish Your Website 

After the completion of the design now it is the time to publish your website on 

web. You can do this either with the tools using your hosting service or with FTP 

clients. Knowing which you can use depends upon your hosting provider.  

Step 6: Promote Your Website 

There are many ways to promote a website such as web search engine, word of 

mouth, email, and advertising. You build your Web content so that it ranks well 

in commonly used search engines. This can be difficult, but it is inexpensive and 

can result in good results if you work at it. 

Step 7: Maintain Your Website 

Maintenance is the last step of constructing a site which helps in keeping your site 

updated with the latest trends of market. In order to keep your site going well and 

looking good, you need to test your site frequently. And you should also work on 

content development on a regular basis. 

1.5 Website Publishing 

Website publishing is the process of uploading content on the internet. It includes: 

 uploading files 

 updating web pages 

 posting blogs 

Website is published by uploading files on the remote server which is provided by the 

hosting company. 
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1. Prerequisites for Website Publishing 

In order to publish your site, you need the following things: 

 Web development software 

 Internet Connection 

 Web Server 

2. Web development software 

It is used for building web pages for your web site. Dreamweaver and WordPress 

are example of web development software. 

3. Internet Connection 

Internet connection is required to connect to a remotely located web server. 

4. Web Server 

Web server is the actual location where your website resides on. A web server 
may host single or multiple sites depending on what hosting service you have 

paid for. 
 

1.6 Website URL Registration  

A domain name is the part of your Internet address that comes after "www". For 

example, in www.learningpoint.com the domain name is learningpoint.com. A domain 

name becomes your Business Address so care should be taken to select a domain name. 

Your domain name should be easy to remember and easy to type. 

Domain Extensions 

The final letter at end of internet address is known as top level domain names. They are 

called top level because they are read from right to left, and the part after the dot is the 

highest in a hierarchy. The table shows the Generic Top-Level Domain names: 

 

 

 

 

 

 

 

 

Registering Domain Name 

Domain Meaning 

.com Commercial Business 

.edu Education 

.gov U.S. government agency 

.int International Entity 

.mil U.S. military 

.net Networking organization 

.org Non-profit organization 

S.N. Domain Name Registrar 

1 Address Creation, LLC 

2 Addressonthe web, LLC 

3 101domains, INC 

4 Atomicdomainnames, LLC 

5 BigRock Solutions Ltd 
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Registering a Domain Name is very simple. You can take following step to get your 

desired domain name registered: 

 Think of a name that justifies your business need. To find out the available 

names you can enter a name at commercial domain name registrar such as 

GoDaddy. 

 If the domain name entered by you is available, then select that particular domain 

name. 

 Now it will ask you for other additional services such as Email inbox, hosting 

etc. that host also provides. You may choose what’s best for you. 

 Now they will ask you for your personal information which is stored in WHOIS 

database. 

 It will then ask for payment information. Pay for the purchase you have made. 

Make sure you enter the correct payment information. 

 Once you are done with all above steps, you are ready to use their tools to upload 

your stuff to your site. 

Domain Name Registrar 

There are a number of domain name registrars available in the market. The above 

table contains some of popular domain name registrars: 

 

1.7 Website Hosting 

Web hosting is a service of providing online space for storage of web pages. These web 

pages are made available via World Wide Web. The companies which offer website 

hosting are known as Web hosts.  The servers on which web site is hosted remain 

switched on 24 x7. These servers are run by web hosting companies. Each server has its 

own IP address. Since IP addresses are difficult to remember therefore, webmaster points 

their domain name to the IP address of the server their website is stored on. 

It is not possible to host your website on your local computer, to do so you would have to 

leave your computer on 24 hours a day. This is not practical and cheaper as well. This is 

where web hosting companies comes in. 

Types of Hosting 

The following table describes different types of hosting that can be availed as per the 

need: 

6 Black Ice Domain, Inc 

7 Block Host LLC 

8 Domain Monkeys, LLC 

9 Domain Mantra, Inc. 

10 DomainName, Inc. 

11 Dot Holding Inc. 

12 DotMedia Ltd 

13 Extend Names, Inc. 

14 Extremely Wild 

15 Fast Domain Inc. 

16 Google Inc 
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S.N. Hosting Description 

1 Shared Hosting 

In shared hosting, the hosting company puts thousands of website on the same 

physical server. Each customer has their own allocation of physical web space 

and a set of bandwidth limit. As all websites share same physical memory, 

MYSQL server and Apache server, one website on the server experiencing 

high traffic load will affect performance of all websites on the server. 

2 Virtual Private Server VPS 

It is also known as Virtual Dedicated Server. It is a server which is partitioned 

into smaller servers. In this customer is given their own partition, which is 

installed with its own operating system. Unlike shared hosting, VPS doesn’t 

share memory or processor time rather it allocates certain amount of memory 

and CPU to use which means that any problem on a VPS partition on the same 

drive will not affect other VPS customers. 

3 Dedicated Server 

In this kind of hosting, single dedicated server is setup for just one customer. It 

is commonly used by the businesses that need the power, control and security 

that a dedicated server offers. 

4 Reseller Hosting 

A reseller acts as a middle man and sells hosting space of someone else’s 

server 

5 Grid Hosting 

Instead of utilizing one server, Grid Hosting spreads resources over a large 

number of servers. It is quite stable and flexible. The servers can be added or 

taken away from the grid without crashing the system. 

 

WEB HOSTING COMPANIES 

Following are the several companies offering web hosting service 

 

 

 

 

 

 

 

 

 

S.N.  Hosting Company 

1 Blue Host 

2 Go Daddy 

3 Host Gator 

4 just Host 

5 Laughing Squid 

6 Hivelocity 

7 liquid Web 

8 Media TempleServInt 

9 Wired Tree 

10 Wild West Domains 

11 Wix 

12 WIPL 

13 Big Rock 
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1.8 Website Security 

 

Why Website Security Is Important 

If you run a website whether business or personal then ensuring that it is secure is 

important for a number of reasons, as shown below: 

 To prevent Malware (viruses) being uploaded to your site 

 To prevent Phishing emails being sent via your website 

 To reassure your website visitors that your website is safe 

 To get a better ranking in the search engines like Google 

 To protect your business from getting hacked and to protect against losing vital 

data 

What Happens If Your Website Is Not Secure? 

If your website is not secure then hackers and criminals can target your website and 
exploit any weaknesses. They have a range of hacking tools at their disposal but the 

main ones are: 
 Man In The Middle (MITM) Attack – this is where details are accessed between 

your website and the person’s browser 

 Malware Uploads – Malware is injected to your website through vulnerabilities in 
the code 

The following are the tips to help keep you and your site safe online. 

01. Keep software up to date 

It may seem obvious, but ensuring you keep all software up to date is vital in keeping 
your site secure. This applies to both the server operating system and any software you 

may be running on your website such as a CMS or forum. When website security holes 
are found in software, hackers are quick to attempt to abuse them. If you are using third-
party software on your website such as a CMS or forum, you should ensure you are quick 

to apply any security patches.  

02. SQL injection 

SQL injection attacks are when an attacker uses a web form field or URL parameter to 

gain access to or manipulate your database. When you use standard Transact SQL it is 
easy to unknowingly insert rogue code into your query that could be used to change 
tables, get information and delete data. You can easily prevent this by always using 

parameterized queries, most web languages have this feature and it is easy to implement. 

03. XSS 

Cross-site scripting (XSS) attacks inject malicious JavaScript into your pages, which then 

runs in the browsers of your users, and can change page content, or steal information to 
send back to the attacker. For example, if you show comments on a page without 

validation, then an attacker might submit comments containing script tags and JavaScript, 
which could run in every other user's browser and steal their login cookie, allowing the 
attack to take control of the account of every user who viewed the comment. You need to 

ensure that users cannot inject active JavaScript content into your pages. 
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04. Error messages 

Be careful with how much information you give away in your error messages. Provide 
only minimal errors to your users, to ensure they don't leak secrets present on your server 

(e.g. API keys or database passwords). Don't provide full exception details either, as 
these can make complex attacks like SQL injection far easier. Keep detailed errors in 

your server logs, and show users only the information they need. 

05. Server side validation/form validation 

Validation should always be done both on the browser and server side. The browser can 
catch simple failures like mandatory fields that are empty and when you enter text into a 

numbers only field. These can however be bypassed, and you should make sure you 
check for these validation and deeper validation server side as failing to do so could lead 

to malicious code or scripting code being inserted into the database or could cause 
undesirable results in your website. 
06. Passwords 

Everyone knows they should use complex passwords, but that doesn’t mean they 
always do. It is crucial to use strong passwords to your server and website admin 

area, but equally also important to insist on good password practices for your users to 
protect the security of their accounts. 
As much as users may not like it, enforcing password requirements such as a 

minimum of around eight characters, including an uppercase letter and number will 
help to protect their information in the long run. 

Passwords should always be stored as encrypted values, preferably using a one way 
hashing algorithm such as SHA. Using this method means when you are 
authenticating users you are only ever comparing encrypted values. For extra website 

security it is a good idea to salt the passwords, using a new salt per password. 

07. File uploads 

Allowing users to upload files to your website can be a big website security risk, even 

if it’s simply to change their avatar. The risk is that any file uploaded however 
innocent it may look, could contain a script that when executed on your server 
completely opens up your website. 

08. HTTPS 

HTTPS is a protocol used to provide security over the Internet. HTTPS guarantees to 
users that they're talking to the server they expect, and that nobody else can intercept 

or change the content they're seeing in transit. 

09. Website security tools 

Once you think you have done all you can then it's time to test your website security. 
The most effective way of doing this is via the use of some website security tools, 

often referred to as penetration testing or pen testing for short. 
 

There are many commercial and free products to assist you with this. They work on a 
similar basis to scripts hackers will use in that they test all know exploits and attempt 
to compromise your site using some of the previous mentioned methods such as SQL 

injection. 
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Some free tools that are worth looking at: 

 
 Netsparker (Free community edition and trial version available). Good for testing 

SQL injection and XSS 
 OpenVAS. Claims to be the most advanced open source security scanner. Good 

for testing known vulnerabilities, currently scans over 25,000. But it can be 

difficult to setup and requires a OpenVAS server to be installed which only runs 
on *nix. OpenVAS is fork of a Nessus before it became a closed-source 

commercial product. 
 SecurityHeaders.io (free online check). A tool to quickly report which security 

headers mentioned above (such as CSP and HSTS) a domain has enabled and 

correctly configured. 
 Xenotix XSS Exploit Framework A tool from OWASP (Open Web Application 

Security Project) that includes a huge selection of XSS attack examples, which 
you can run to quickly confirm whether your site's inputs are vulnerable in 
Chrome, Firefox and IE. 

 

1.9 Summary   

 

 .Website: 

 A collection of web pages which are grouped together and usually connected 

together in various ways. Often called a "web site" or simply a "site." 

 Webpage: 

 A document which can be displayed in a web browser such as Firefox, Google 

Chrome, Microsoft Internet Explorer or Edge, or Apple's Safari. These are also 

often called "web pages" or just "pages." 

 web server 

 A computer that hosts a website on the Internet. 

 search engine 

 A website that helps you find other web pages, such as Google, Bing, or Yahoo. 

 Dynamic Website :  

 Dynamic website is a collection of dynamic web pages whose content changes 

dynamically. It accesses content from a database or Content Management System 

(CMS).  

 Statics Website : 

 Static website is the basic type of website that is easy to create. You don't need 

web programming and database design to create a static website. Its web pages 

are coded in HTML. The codes are fixed for each page so the information 

contained in the page does not change and it looks like a printed page. 

http://www.mavitunasecurity.com/netsparker/
http://www.openvas.org/
http://www.tenable.com/products/nessus/
http://www.creativebloq.com/web-design/SecurityHeaders.io
https://xenotix.in/
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Static vs. Dynamic website 

Static Website Dynamic Website 

Prebuilt content is same every time the 

page is loaded. 

Content is generated quickly and changes 

regularly. 

It uses the HTML code for developing 

a website. 

It uses the server side languages such 

as PHP, SERVLET, JSP, and 

ASP.NET etc. for developing a website. 

It sends exactly the same response for 

every request. 

It may generate different HTML for each 

of the request. 

The content is only changes when 

someone publishes and updates the file 
(sends it to the web server). 

The page contains "server-side" code it 

allows the server to generate the unique 
content when the page is loaded. 

Flexibility is the main advantage of 

static website. 

Content Management System (CMS) is the 

main advantage of dynamic website. 

 

 HTTP: It is the data communication protocol used to establish communication 

between client and server. 

 Webhosting: A web host, or web hosting service provider, is a business that provides 

the technologies and services needed for the website or webpage to be viewed in 

the Internet. Websites are hosted, or stored, on special computers called servers. 

 Domain Name System - The Domain Name System (DNS) is a hierarchical 

decentralized naming system for computers, services, or other resources connected to 

the Internet or a private network. It associates various information with domain 

names assigned to each of the participating entities. 

 Domain Name Servers (DNS) are the Internet's equivalent of a phone book. They 

maintain a directory of domain names and translate them to Internet Protocol (IP) 

addresses. This is necessary because, although domain names are easy for people to 

remember, computers or machines, access websites based on IP addresses. 

 Website security certificate - A website security certificate  is a validation and 

encryption tool, part of the HTTPS protocol, which secures and encrypts data going 

back and forth between the server and the client browser. It is issued by a trusted 

certification authority (CA) who verifies the identity of the owner of a website. 

 

1.10 Check Your Progress 

 

1. Answer the following Questions: 

a) What is a website? 
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____________________________________________________________________ 

b) How many types of websites are there? 

 

____________________________________________________________________ 

c) What are static and dynamic websites? 

 

____________________________________________________________________ 

d) Explain the anatomy of a webpage. 

 

____________________________________________________________________ 

e) Why website security is important? 

_________________________________________________________________

_________________________________________________________________ 

 

1.11 Check Your Progress -Possible Answer 

1. 

(a) A collection of web pages which are grouped together and usually connected 

together in various 

ways. Often called a 

"web site" or simply 

a "site." 

(b) Two types of 

website. 

(c) Static website is the 

basic type of website 

that is easy to create. 

You don't need web 

programming and 

database design to 

create a static 

website. Its web 

pages are coded in HTML. The codes are fixed for each page so 
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the information contained in the page does not change and it looks like a 

printed page. 

Dynamic website is a collection of dynamic web pages whose content 

changes dynamically. It accesses content from a database or Content 

Management System (CMS).  

(d) Web Page Anatomy 

A web site includes the following components: 

1. Containing Block 

Container can be in the form of page’s body tag, an all containing div tag. Without 

container there would be no place to put the contents of a web page. 

2. Logo 

Logo refers to the identity of a website and is used across a company’s various forms 

of marketing such as business cards, letterhead, broachers and so on. 

3. Navigation 

The site’s navigation system should be easy to find and use. Oftenly the navigation 

is placed right at the top of the page. 

4. Content 

The content on a web site should be relevant to the purpose of the web site. 

5. Footer 

Footer is located at the bottom of the page. It usually contains copyright, contract and 

legal information as well as few links to the main sections of the site. 

6. Whitespace 

It is also called as negative space and refers to any area of page that is not covered 

by type or illustrations. 

(e) If you run a website whether business or personal then ensuring that it is 

secure is important for a number of reasons, as shown below: 

 To prevent Malware (viruses) being uploaded to your site 

 To prevent Phishing emails being sent via your website 

 To reassure your website visitors that your website is safe 

 To get a better ranking in the search engines like Google 

 To protect your business from getting hacked and to protect against 

losing vital data 

1.12 References 

1. Computer Networks and Internets with Internet Applications (Third 

Edition) 

2. www.google.com 

3. www.javapoints .com 

4. www.Tutorial points .com 
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UNIT -II 

XHTML and HTML-5 

 

Learning objectives:- 

At the end of this unit the students will be able to: 

 Define HTML. 

 Known about XHTML 

 Understand why to use XHTML? 

 Know the attributes and syntax of XHTML 

 Know about the web sockets , canvas , audio & video  

 Know about web messaging 

STRUCTURE 

2.1 What is XHTML 

2.2 Why use XHTML 

2.3 HTML vs XHTML 

2.4 XHTML Syntax 

2.5 XHTML Events 

2.6 XHTML Doctypes 

2.7 XHTML Attributes 

2.8 Difference between HTML4 and HTML5 

2.9 Difference between HTML and XHTML 

2.10 Overview of HTML 5 

2.11 Syntax, Attributes, Events of HTML5 

2.12 SVG, MathML, Web Storage 

2.13 Web SQL, Server-Sent Events 

2.14 Web Socket, Canvas, Audio & Video 

2.15 Geolocation, Microdata, Drag & drop, Web Workers 

2.16 Web Messaging, Web CORS, Web RTC. 

2.17 Check your Progress 

2.18 Check your Progress- possible answer 

2.19 References 

 

 

 

 

 

 

https://www.javatpoint.com/why-use-xhtml
https://www.javatpoint.com/html-vs-xhtml
https://www.javatpoint.com/xhtml-syntax
https://www.javatpoint.com/xhtml-events
https://www.javatpoint.com/xhtml-doctypes
https://www.javatpoint.com/xhtml-attributes
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2.1 What is XHTML 

XHTML stands for Extensible Hypertext Markup Language. It is the next step in the 

evolution of the internet. The XHTML 1.0 is the first document type in the XHTML 

family. 

XHTML is almost identical to HTML 4.01 with only few differences. This is a cleaner 

and stricter version of HTML 4.01. If you already know HTML, then you need to give 

little attention to learn this latest version of HTML. 

XHTML was developed by World Wide Web Consortium (W3C) to help web 

developers make the transition from HTML to XML. By migrating to XHTML today, 

web developers can enter the XML world with all of its benefits, while still remaining 

confident in the backward and future compatibility of the content. 

2.2 Why Use XHTML? 

Developers who migrates their content to XHTML 1.0 get the following benefits − 

 XHTML documents are XML conforming as they are readily viewed, edited, and 

validated with standard XML tools. 

 XHTML documents can be written to operate better than they did before in 

existing browsers as well as in new browsers. 

 XHTML documents can utilize applications such as scripts and applets that rely 

upon either the HTML Document Object Model or the XML Document Object 

Model. 

 XHTML gives you a more consistent, well-structured format so that your 

WebPages can be easily parsed and processed by present and future web 

browsers. 

 You can easily maintain, edit, convert and format your document in the long run. 

 Since XHTML is an official standard of the W3C, your website becomes more 

compatible with many browsers and it is rendered more accurately. 

 XHTML combines strength of HTML and XML. Also, XHTML pages can be 

rendered by all XML enabled browsers. 

https://www.javatpoint.com/what-is-xhtml
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2.3 HTML Vs XHTML 

HTML XHTML 

HTML is Hypertext Markup Language. XHTML is Extensible Hypertext Markup 

Language. 

An application of SGML. An application of XML. 

Can have empty/open tags e.g. <br>, <p>. All the unclosed tags must be closed 

 e.g. <br/>, <p></p>. 

No hard rule on structures of the elements 

e.g. <p><b>The difference</p></b>. 

Structure of the elements should be followed 

e.g. <p><b> The difference</b></p>. 

Attributes have quotes as optional  

e.g. <font color=#ff0000>. 

Attributes have quotes mandatory 

 e.g. <font color=”#ff0000?>. 

Attributes values not significant e.g. <input 

type=”checkbox” checked>. 

Attributes values are important e.g. <input 

type=”checkbox” checked = “checked”>. 

Case insensitive: The tags and attributes can 

be of uppercase or lowercase as per the 

preference. 

Case sensitive: The tags and attributes must 

be of lowercase. 

All the content can be put under body 

element. 

All the content has to be put in blocks (p, 

under body element. 

HTML is not mandatory for one root 

element. 

XHTML documents must have one root 

element. 

 

2.4 XHTML Syntax 

XHTML syntax is very similar to HTML syntax and almost all the valid HTML elements 

are valid in XHTML as well. But when you write an XHTML document, you need to pay 

a bit extra attention to make your HTML document compliant to XHTML. 

Here are the important points to remember while writing a new XHTML document or 

converting existing HTML document into XHTML document − 

 Write a DOCTYPE declaration at the start of the XHTML document. 

 Write all XHTML tags and attributes in lower case only. 

 Close all XHTML tags properly. 

 Nest all the tags properly. 

 Quote all the attribute values. 

 Forbid Attribute minimization. 
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 Replace the name attribute with the id attribute. 

 Deprecate the language attribute of the script tag. 

Here is the detail explanation of the above XHTML rules − 

DOCTYPE Declaration 

All XHTML documents must have a DOCTYPE declaration at the start. There are three 

types of DOCTYPE declarations. 

 Here is an example of using DOCTYPE − 

<! DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 

"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 

 Case Sensitivity 

XHTML is case sensitive markup language. All the XHTML tags and attributes need to 

be written in lower case only. 

<!-- This is invalid in XHTML --> 

<A Href="/xhtml/xhtml_tutorial.html">XHTML Tutorial</A> 

 

<!-- Correct XHTML way of writing this is as follows --> 

<a href="/xhtml/xhtml_tutorial.html">XHTML Tutorial</a> 

In the example, Href and anchor tag A are not in lower case, so it is incorrect. 

 Closing the Tags 

Each and every XHTML tag should have an equivalent closing tag, even empty elements 

should also have closing tags. Here is an example showing valid and invalid ways of 

using tags − 

<!-- This is invalid in XHTML --> 

<p>This paragraph is not written according to XHTML syntax. 

 

<!-- This is also invalid in XHTML --> 

<img src="/images/xhtml.gif" > 

The following syntax shows the correct way of writing above tags in XHTML. 

Difference is that, here we have closed both the tags properly. 

<!-- This is valid in XHTML --> 

<p>This paragraph is not written according to XHTML syntax.</p> 

 

<!-- This is also valid now --> 

<img src="/images/xhtml.gif" /> 
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 Attribute Quotes 

All the values of XHTML attributes must be quoted. Otherwise, your XHTML document 

is assumed as an invalid document. Here is the example showing syntax − 

<!-- This is invalid in XHTML --> 

<img src="/images/xhtml.gif" width=250 height=50 /> 

 

<!-- Correct XHTML way of writing this is as follows --> 

<img src="/images/xhtml.gif" width="250" height="50" /> 

 Attribute Minimization 

XHTML does not allow attribute minimization. It means you need to explicitly state the 

attribute and its value. The following example shows the difference − 

<!-- This is invalid in XHTML --> 

<option selected> 

 

<!-- Correct XHTML way of writing this is as follows --> 

<option selected="selected"> 

Here is a list of the minimized attributes in HTML and the way you need to write them 

in XHTML − 

HTML Style XHTML Style 

compact compact="compact" 

checked checked="checked" 

declare declare="declare" 

readonly readonly="readonly" 

disabled disabled="disabled" 

selected selected="selected" 

defer defer="defer" 

ismap ismap="ismap" 

nohref nohref="nohref" 

noshade noshade="noshade" 

nowrap nowrap="nowrap" 

multiple multiple="multiple" 

noresize noresize="noresize" 

 

2.5   XHTML Events 

 

When users visit a website, they do things such as click on text, images and hyperlinks, 

hover-over things, etc. These are examples of what JavaScript calls events. 

https://www.javatpoint.com/xhtml-events
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We can write our event handlers in JavaScript or VBScript and can specify these event 

handlers as a value of event tag attribute. The XHTML 1.0 has a similar set of events 

which is available in HTML 4.01 specification. 

The <body> and <frameset> Level Events 

There are only two attributes which can be used to trigger any JavaScript or VBScript 

code, when any event occurs at document level. 

Attribute Value Description 

onload Script Script runs when a XHTML document loads. 

onunload Script Script runs when a XHTML document unloads. 

Note − Here, the script refers to any function or piece of code of VBScript or 

JavaScript. 

The <form> Level Events 

There are following six attributes which can be used to trigger any JavaScript or 

VBScript code when any event occurs at form level. 

Attribute Value Description 

onchange Script Script executes when the element changes. 

onsubmit Script Script executes when the form is submitted. 

onreset Script Script executes when the form is reset. 

onselect Script Script executes when the element is selected. 

onblur Script Script executes when the element loses focus. 

onfocus Script Script runs when the element gets focus. 

Keyboard Events 

The following three events are generated by keyboard. These events are not valid in 

base, bdo, br, frame, frameset, head, html, iframe, meta, param, script, style, and title 

elements. 

Attribute Value Description 

onkeydown Script Script executes on key press. 
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onkeypress Script Script executes on key press and release. 

onkeyup Script Script executes key release. 

Other Events 

The following seven events are generated by mouse when it comes in contact with any 

HTML tag. These events are not valid in base, bdo, br, frame, frameset, head, html, 

iframe, meta, param, script, style, and title elements. 

Attribute Value Description 

onclick Script Script executes on a mouse click. 

ondblclick Script Script executes on a mouse double-click. 

onmousedown Script Script executes when mouse button is pressed. 

onmousemove Script Script executes when mouse pointer moves. 

onmouseout Script Script executes when mouse pointer moves out of an 

element. 

onmouseover Script Script executes when mouse pointer moves over an 

element. 

onmouseup Script Script executes when mouse button is released. 

 

 

2.6 XHTML Doctypes 

 

The XHTML standard defines three Document Type Definitions (DTDs). The most 

commonly used and easy one is the XHTML Transitional document. 

XHTML 1.0 document type definitions correspond to three DTDs − 

 Strict 

 Transitional 

 Frameset 

There are few XHTML elements and attributes, which are available in one DTD but not 

available in another DTD. Therefore, while writing your XHTML document, you must 

select your XHTML elements or attributes carefully. However, XHTML validator helps 

https://www.javatpoint.com/xhtml-doctypes
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you to identify valid and invalid elements and attributes. 

Please check XHTML Validations for more detail on this. 

XHTML 1.0 Strict 

If you are planning to use Cascading Style Sheet (CSS) strictly and avoiding writing 

most of the XHTML attributes, then it is recommended to use this DTD. A document 

conforming to this DTD is of the best quality. 

If you want to use XHTML 1.0 Strict DTD then you need to include the following line 

at the top of your XHTML document. 

<! DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd"> 

XHTML 1.0 Transitional 

If you are planning to use many XHTML attributes as well as few Cascading Style 

Sheet properties, then you should adopt this DTD and you should write your XHTML 

document accordingly. 

If you want to use XHTML 1.0 Transitional DTD, then you need to include the 

following line at the top of your XHTML document. 

<! DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 

"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 

XHTML 1.0 Frameset 

You can use this when you want to use HTML Frames to partition the browser window 

into two or more frames. 

If you want to use XHTML 1.0 Frameset DTD, then you need to include following line 

at the top of your XHTML document. 

<! DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Frameset//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-frameset.dtd"> 

2.7 XHTML Attributes 
 

1 There are a few XHTML/HTML attributes which are standard and associated to all 

the XHTML/HTML tags. These attributes are listed here with brief description − 

2 Core Attributes 

3 Not valid in base, head, html, meta, param, script, style, and title elements. 

 

https://www.tutorialspoint.com/xhtml/xhtml_validations.htm
https://www.javatpoint.com/xhtml-attributes
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Attribute Value Description  

class class_rule or style_rule The class of the element. 

Id id_name A unique id for the element. 

style style_definition An inline style definition. 

Title tooltip_text A text to display in a mouse tip. 

 
2.8   Difference between HTML4 and HTML5 

 

HTML 5 HTML 4 

Syntax: 

It has Simplified and clear syntax. 

For doctype use: <!DOCTYPE html> 

Syntax:  

It's Syntax is little complex. 

For doctype used: <!DOCTYPE HTML 

PUBLIC "-//W3C//DTD HTML 4.01//EN" 

"http://www.w3.org/TR/html4/strict.dtd"> 

Multimedia: 

HTML5 contains built in support for 

integrated multimedia files into web 

page via video and audio tags. 

Multimedia:  

The multimedia content was integrated in web 

pages via third party plugins such as Silverlight 

and flash. 

HTML 5 has many new elements that 

are not present in HTML 4. 

Added more elements to HTML 5 which does 

not exist in HTML 4. 

HTML 5 has dropped certain 

elements. 

The elements exist in HTML 4 has been 

removed from HTML 5 and few deprecated 

tags. 

Is being developed by web hypertext 

application technology working group 

(WHATWG) and W3C HTML WG. 

Was developed by World Wide Web 

consortium and WHATWG (web hypertext 

application technology working group). 

User Geographical location: 

On the other hand, in HTML5 is 

extremely easy to get the user location. 

HTML5’s JS GeoLocation can be 

leveraged to identify the location of 

the user accessing the website. 

User Geographical location: 

In HTML4, it was an extremely cumbersome 

task to get the geographical locations of the 

visitors visiting the site. It was even difficult 

when the website was accessed through mobile 

devices. 
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Client Side storage: 

In HTML5, this issue has been 

addressed via Web SQL database and 

application cache that can be access 

via HTML5’s JavaScript interface. 

Client Side storage: 

In HTML4, in order to store important data on 

client side, browser’s cache was used. However, 

that cache is limited and doesn’t support 

relational storage mechanism. 

Client Server Communication: 

Other side, HTML5 contains web 

sockets that allow full duplex 

communication between clients and 

servers. 

Client Server Communication: 

In HTML4 the communication between the 

client and server was done through streaming 

and long polling, since there are no web sockets 

available in HTML4. 

JavaScript Threading Mechanism: 

HTML5 contains JS Web Worker API 

which allows JavaScript and Browser 

interface to run in separate threads. 

JavaScript Threading Mechanism: 

In HTML4, JavaScript and the browser 

interface with which user interacts, run in the 

same thread which affects performance.  

 
2.9 Difference between HTML and XHTML 

 
 HTML XHTML 

Introduction 

(from 

Wikipedia) 

HTML or Hypertext 
Markup Language is the 
main markup language for 

creating web pages and 
other information that can 
be displayed in a web 

browser. 

XHTML (Extensible Hypertext Markup 
Language) is a family of XML markup 
languages that mirror or extend versions of 

the widely used Hypertext Markup 
Language (HTML), the language in which 
web pages are written. 

Filename 

extension 

.html, .htm .xhtml, .xht, .xml, .html, .htm 

Internet 

media type 

text/html application/xhtml+xml 

Developed by W3C & WHATWG World Wide Web Consortium 

Type of 

format 

Document file format Markup language 

Extended 

from 

SGML XML, HTML 

Stands for HyperText Markup 
Language 

Extensible HyperText Markup Language 

Application Application of Standard 
Generalized Markup 
Language (SGML). 

Application of XML 
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Function Web pages are written in 
HTML. 

Extended version of HTML that is stricter 
and XML-based. 

Nature Flexible framework 
requiring lenient HTML 
specific parser. 

Restrictive subset of XML and needs to be 
parsed with standard XML parsers. 

Origin Proposed by Tim Berners-
Lee in 1987. 

World Wide Web Consortium 
Recommendation in 2000. 

Versions HTML 2, HTML 3.2, 
HTML 4.0, HTML 5. 

XHTML 1, XHTML 1.1, XHTML 2, 
XHTML 5. 

 
 

2.10 Overview of HTML 5 

 
HTML5 is the next major revision of the HTML standard superseding HTML 4.01, 

XHTML 1.0, and XHTML 1.1. HTML5 is a standard for structuring and presenting 

content on the World Wide Web. 

HTML5 is cooperation between the World Wide Web Consortium (W3C) and the Web 

Hypertext Application Technology Working Group (WHATWG). 

The new standard incorporates features like video playback and drag-and-drop that have 

been previously dependent on third-party browser plug-ins such as Adobe Flash, 

Microsoft Silver light, and Google Gears. 

Browser Support 

The latest versions of Apple Safari, Google Chrome, Mozilla Firefox, and Opera all 

support many HTML5 features and Internet Explorer 9.0 will also have support for 

some HTML5 functionality. 

New Features 

HTML5 introduces a number of new elements and attributes that helps in building a 

modern website. Following are great features introduced in HTML5. 

 New Semantic Elements − These are like <header>, <footer>, and <section>. 

 Forms 2.0 − Improvements to HTML web forms where new attributes have been 

introduced for <input> tag. 

 Persistent Local Storage  − To achieve without resorting to third-party plugins. 

 WebSocket − A a next-generation bidirectional communication technology for 

web applications. 

 Server-Sent Events − HTML5 introduces events which flow from web server to 

the web browsers and they are called Server-Sent Events (SSE). 

 Canvas − This supports a two-dimensional drawing surface that you can 

program with JavaScript. 

 Audio & Video − You can embed audio or video on your web pages without 

resorting to third-party plugins. 
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 Geolocation − Now visitors can choose to share their physical location with your 

web application. 

 Microdata − This lets you create your own vocabularies beyond HTML5 and 

extend your web pages with custom semantics. 

 Drag and drop − Drag and drop the items from one location to another location 

on the same webpage. 

 

2.11 Syntax, Attributes, Events of HTML5 

 
SYNTAX 

The HTML 5 language has a "custom" HTML syntax that is compatible with HTML 4 

and XHTML1 documents published on the Web, but is not compatible with the more 

esoteric SGML features of HTML 4. 

HTML 5 does not have the same syntax rules as XHTML where we needed lower case 

tag names, quoting our attributes; an attribute had to have a value and to close all empty 

elements. 

But HTML5 is coming with lots of flexibility and would support the followings − 

 Uppercase tag names. 

 Quotes are optional for attributes. 

 Attribute values are optional. 

 Closing empty elements are optional. 

The DOCTYPE 

DOCTYPEs in older versions of HTML were longer because the HTML language was 

SGML based and therefore required a reference to a DTD. 

HTML 5 authors would use simple syntax to specify DOCTYPE as follows − 

<! DOCTYPE html> 

All the above syntax is case-insensitive. 

Character Encoding 

HTML 5 authors can use simple syntax to specify Character Encoding as follows − 

<meta charset="UTF-8"> 

All the above syntax is case-insensitive. 

The <script> tag 
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It's common practice to add a type attribute with a value of "text/javascript" to script 

elements as follows − 

<script type="text/javascript" src="scriptfile.js"></script> 

HTML 5 removes extra information required and you can use simply following syntax − 

<script src="scriptfile.js"></script> 

The <link> tag 

So far you were writing <link> as follows − 

<link rel="stylesheet" type="text/css" href="stylefile.css"> 

HTML 5 removes extra information required and you can use simply following syntax − 

<link rel="stylesheet" href="stylefile.css"> 

HTML5 ATTRIBUTES 

Elements may contain attributes that are used to set various properties of an element. 

Some attributes are defined globally and can be used on any element, while others are 

defined for specific elements only. All attributes have a name and a value and look like 

as shown below in the example. 

Following is the example of an HTML5 attributes which illustrates how to mark up a 

div element with an attribute named class using a value of "example" − 

<div class="example">...</div> 

Attributes may only be specified within start tags and must never be used in end tags. 

HTML5 attributes are case insensitive and may be written in all upper case or mixed 

case, although the most common convention is to stick with lower case. 

Here is a complete list of HTML5 Attributes. 

HTML5 Document 

The following tags have been introduced for better structure − 

 section − This tag represents a generic document or application section. It can be 

used together with h1-h6 to indicate the document structure. 

 article − This tag represents an independent piece of content of a document, such 

as a blog entry or newspaper article. 

 aside − This tag represents a piece of content that is only slightly related to the 

rest of the page. 

 header − This tag represents the header of a section. 

https://www.tutorialspoint.com/html5/html5_attributes.htm
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 footer − This tag represents a footer for a section and can contain information 

about the author, copyright information, etc. 

 nav − This tag represents a section of the document intended for navigation. 

 dialog − This tag can be used to mark up a conversation. 

 figure − This tag can be used to associate a caption together with some 

embedded content, such as a graphic or video. 

The markup for an HTM 5 document would look like the following − 

<!DOCTYPE html> 

<html> 
 
<head> 

<meta charset="utf-8"> 
<title>...</title> 

</head> 
  
<body> 

<header>...</header> 
<nav>...</nav> 

   
<article> 
<section> 

            ... 
</section> 

</article> 
   
<aside>...</aside> 

<figure>...</figure> 
<footer>...</footer> 

 
</body> 
</html> 

 

 EVENTS OF HTML5 

When a user visits your website, they do things like click on text and images and given 

links, hover over things etc. These are examples of what JavaScript calls events. 

We can write our event handlers in Javascript or vbscript and you can specify these 

event handlers as a value of event tag attribute. The HTML5 specification defines 

various event attributes as listed below − 

We would cover element specific events while discussing those elements in detail in 
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Attribute Value Description 

Offline script Triggers when the document goes offline 

Onabort script Triggers on an abort event 

Onafterprint script Triggers after the document is printed 

Onbeforeonload script Triggers before the document loads 

Onbeforeprint script Triggers before the document is printed 

Onblur script Triggers when the window loses focus 

Oncanplay script Triggers when media can start play, but might has to 
stop for buffering 

oncanplaythrough script Triggers when media can be played to the end, 
without stopping for buffering 

Onchange script Triggers when an element changes 

Onclick script Triggers on a mouse click 

Oncontextmenu script Triggers when a context menu is triggered 

Ondblclick script Triggers on a mouse double-click 

Ondrag script Triggers when an element is dragged 

Ondragend script Triggers at the end of a drag operation 

Ondragenter script Triggers when an element has been dragged to a 

valid drop target 

Ondragleave script Triggers when an element leaves a valid drop target 

Ondragover script Triggers when an element is being dragged over a 
valid drop target 

Ondragstart script Triggers at the start of a drag operation 

Ondrop script Triggers when dragged element is being dropped 

ondurationchange script Triggers when the length of the media is changed 

Onemptied script Triggers when a media resource element suddenly 
becomes empty. 

Onended script Triggers when media has reach the end 
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Onerror script Triggers when an error occur 

Onfocus script Triggers when the window gets focus 

Onformchange script Triggers when a form changes 

Onforminput script Triggers when a form gets user input 

Onhaschange script Triggers when the document has change 

Oninput script Triggers when an element gets user input 

Oninvalid script Triggers when an element is invalid 

Onkeydown script Triggers when a key is pressed 

Onkeypress script Triggers when a key is pressed and released 

Onkeyup script Triggers when a key is released 

Onload script Triggers when the document loads 

Onloadeddata script Triggers when media data is loaded 

onloadedmetadata script Triggers when the duration and other media data of 

a media element is loaded 

Onloadstart script Triggers when the browser starts to load the media 

data 

Onmessage script Triggers when the message is triggered 

Onmousedown script Triggers when a mouse button is pressed 

Onmousemove script Triggers when the mouse pointer moves 

Onmouseout script Triggers when the mouse pointer moves out of an 
element 

Onmouseover script Triggers when the mouse pointer moves over an 
element 

Onmouseup script Triggers when a mouse button is released 

Onmousewheel script Triggers when the mouse wheel is being rotated 

Onoffline script Triggers when the document goes offline 

Onoine script Triggers when the document comes online 

Ononline script Triggers when the document comes online 
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Onpagehide script Triggers when the window is hidden 

Onpageshow script Triggers when the window becomes visible 

Onpause script Triggers when media data is paused 

Onplay script Triggers when media data is going to start playing 

Onplaying script Triggers when media data has start playing 

Onpopstate script Triggers when the window's history changes 

Onprogress script Triggers when the browser is fetching the media 
data 

Onratechange script Triggers when the media data's playing rate has 
changed 

onreadystatechange script Triggers when the ready-state changes 

Onredo script Triggers when the document performs a redo 

Onresize script Triggers when the window is resized 

Onscroll script Triggers when an element's scrollbar is being 

scrolled 

Onseeked script Triggers when a media element's seeking attribute is 

no longer true, and the seeking has ended 

Onseeking script Triggers when a media element's seeking attribute is 

true, and the seeking has begun 

Onselect script Triggers when an element is selected 

Onstalled script Triggers when there is an error in fetching media 
data 

Onstorage script Triggers when a document loads 

Onsubmit script Triggers when a form is submitted 

Onsuspend script Triggers when the browser has been fetching media 
data, but stopped before the entire media file was 

fetched 

Ontimeupdate script Triggers when media changes its playing position 

Onundo script Triggers when a document performs an undo 

Onunload script Triggers when the user leaves the document 
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Onvolumechange script Triggers when media changes the volume, also 
when volume is set to "mute" 

Onwaiting script Triggers when media has stopped playing, but is 
expected to resume 

 
2.12 SVG, MathML, Web Storage 

 
SVG 

SVG stands for Scalable Vector Graphics and it is a language for describing 2D-graphics 

and graphical applications in XML and the XML is then rendered by an SVG viewer. 

SVG is mostly useful for vector type diagrams like Pie charts, Two-dimensional graphs 

in an X,Y coordinate system etc. 

Viewing SVG Files 

Most of the web browsers can display SVG just like they can display PNG, GIF, and 

JPG. Internet Explorer users may have to install the Adobe SVG Viewer to be able to 

view SVG in the browser. 

Embedding SVG in HTML5 

HTML5 allows embedding SVG directly using <svg>...</svg> tag which has following 

simple syntax − 

<svg xmlns="http://www.w3.org/2000/svg"> 

   ...     

</svg> 

MathML 

The HTML syntax of HTML5 allows for MathML elements to be used inside a 
document using <math>...</math> tags. 

Most of the web browsers can display MathML tags. If your browser does not support 

MathML, then I would suggest you to use latest version of Firefox. 

 MathML Examples 

Following is a valid HTML5 document with MathML − 

<!doctype html> 

<html> 
 
<head> 

<meta charset="UTF-8"> 
<title>Pythagorean theorem</title> 

http://www.adobe.com/svg/viewer/install/
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</head> 
  

<body> 
  

<math xmlns="http://www.w3.org/1998/Math/MathML"> 
   
<mrow> 

<msup><mi>a</mi><mn>2</mn></msup> 
<mo>+</mo> 

     
<msup><mi>b</mi><mn>2</mn></msup> 
<mo>=</mo> 

     
<msup><mi>c</mi><mn>2</mn></msup> 

</mrow> 
    
</math> 

   
</body> 

</html> 

 

 Web Storage 

HTML5 introduces two mechanisms, similar to HTTP session cookies, for storing 

structured data on the client side and to overcome following drawbacks. 

 Cookies are included with every HTTP request, thereby slowing down your web 

application by transmitting the same data. 

 Cookies are included with every HTTP request, thereby sending data 

unencrypted over the internet. 

 Cookies are limited to about 4 KB of data . Not enough to store required data. 

The two storage's are session storage and local storage and they would be used to 

handle different situations. 

The latest versions of pretty much every browser support HTML5 Storage including 

Internet Explorer. 

 Session Storage 

The Session Storage is designed for scenarios where the user is carrying out a single 

transaction, but could be carrying out multiple transactions in different windows at the 

same time. 

Example 

For example, if a user buying plane tickets in two different windows, using the same site. 

If the site used cookies to keep track of which ticket the user was buying, then 
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as the user clicked from page to page in both windows, the ticket currently being 

purchased would "leak" from one window to the other, potentially causing the user to 

buy two tickets for the same flight without really noticing. 

 Local Storage 

The Local Storage is designed for storage that spans multiple windows, and lasts 

beyond the current session. In particular, Web applications may wish to store megabytes 

of user data, such as entire user-authored documents or a user's mailbox, on the client 

side for performance reasons. 

 2.13 Web SQL, Server-Sent Events 

 
Web SQL 

The Web SQL Database API isn't actually part of the HTML5 specification but it is a 

separate specification which introduces a set of APIs to manipulate client-side databases 

using SQL. 

I'm assuming you are a great web developer and if that is the case then no doubt, you 

would be well aware of SQL and RDBMS concepts.  

Web SQL Database will work in latest version of Safari, Chrome and Opera. 

 The Core Methods 

There are following three core methods defined in the spec that I.m going to cover in 

this unit − 

 openDatabase − This method creates the database object either using existing 

database or creating new one. 

 transaction − This method give us the ability to control a transaction and 

performing either commit or roll-back based on the situation. 

 executeSql − This method is used to execute actual SQL query. 

Opening Database 

The openDatabase method takes care of opening a database if it already exists, this 

method will create it if it already does not exist. 

To create and open a database, use the following code − 

var db = openDatabase('mydb', '1.0', 'Test DB', 2 * 1024 * 1024); 

Above method took following five parameters − 

 Database name 

 Version number 

 Text description 

 Size of database 

 Creation callback 
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The last and 5th argument, creation callback will be called if the database is being 

created. Without this feature, however, the databases are still being created on the fly 

and correctly version. 

 Executing queries 

To execute a query you use the database. Transaction () function. This function needs a 

single argument, which is a function that takes care of actually executing the query as 

follows − 

var db = openDatabase('mydb', '1.0', 'Test DB', 2 * 1024 * 1024); 

 

db.transaction(function (tx) {   

   tx.executeSql('CREATE TABLE IF NOT EXISTS LOGS (id unique, log)'); 

}); 

The above query will create a table called LOGS in 'mydb' database. 

 INSERT Operation 

To create eateries into the table we add simple SQL query in the above example as 

follows − 

var db = openDatabase('mydb', '1.0', 'Test DB', 2 * 1024 * 1024); 

db.transaction(function (tx) { 

   tx.executeSql('CREATE TABLE IF NOT EXISTS LOGS (id unique, log)'); 

   tx.executeSql('INSERT INTO LOGS (id, log) VALUES (1, "foobar")'); 

   tx.executeSql('INSERT INTO LOGS (id, log) VALUES (2, "logmsg")'); 

}); 

We can pass dynamic values while creating entering as follows − 

var db = openDatabase('mydb', '1.0', 'Test DB', 2 * 1024 * 1024); 

 

db.transaction(function (tx) {   

   tx.executeSql('CREATE TABLE IF NOT EXISTS LOGS (id unique, log)'); 

   tx.executeSql('INSERT INTO LOGS (id,log) VALUES (?, ?'), [e_id, e_log]; 

}); 

Here e_id and e_log are external variables, and executeSql maps each item in the array 

argument to the "?"s. 

 READ Operation 

To read already existing records we use a callback to capture the results as follows − 

var db = openDatabase('mydb', '1.0', 'Test DB', 2 * 1024 * 1024); 

 

db.transaction(function (tx) { 

   tx.executeSql('CREATE TABLE IF NOT EXISTS LOGS (id unique, log)'); 

   tx.executeSql('INSERT INTO LOGS (id, log) VALUES (1, "foobar")'); 

   tx.executeSql('INSERT INTO LOGS (id, log) VALUES (2, "logmsg")'); 

}); 

 

db.transaction(function (tx) { 
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   tx.executeSql('SELECT * FROM LOGS', [], function (tx, results) { 

      var len = results.rows.length, i; 

      msg = "<p>Found rows: " + len + "</p>"; 

      document.querySelector('#status').innerHTML +=  msg; 

  

      for (i = 0; i < len; i++){ 

         alert(results.rows.item(i).log ); 

      } 

  

   }, null); 

}); 

 Final Example 

So finally, let us keep this example in full fledged HTML5 document as follows and try 

to run it with Safari browser. 

<!DOCTYPE HTML> 

<html> 

 

<head> 

  

<script type="text/javascript"> 

   

         var db = openDatabase('mydb', '1.0', 'Test DB', 2 * 1024 * 1024); 

         var msg; 

    

         db.transaction(function (tx) { 

            tx.executeSql('CREATE TABLE IF NOT EXISTS LOGS (id unique, log)'); 

            tx.executeSql('INSERT INTO LOGS (id, log) VALUES (1, "foobar")'); 

            tx.executeSql('INSERT INTO LOGS (id, log) VALUES (2, "logmsg")'); 

            msg = '<p>Log message created and row inserted.</p>'; 

            document.querySelector('#status').innerHTML =  msg; 

         }); 

 

         db.transaction(function (tx) { 

            tx.executeSql('SELECT * FROM LOGS', [], function (tx, results) { 

               var len = results.rows.length, i; 

               msg = "<p>Found rows: " + len + "</p>"; 

               document.querySelector('#status').innerHTML +=  msg; 

      

               for (i = 0; i < len; i++){ 

                  msg = "<p><b>" + results.rows.item(i).log + "</b></p>"; 

                  document.querySelector('#status').innerHTML +=  msg; 

               } 

            }, null); 



               Odisha State Open University Page 41 

 

         }); 

    

</script> 

   

</head> 

  

<body> 

<div id="status" name="status">Status Message</div> 

</body> 

  

</html> 

It will produce the following result − 

Log message created and row inserted. 

Found rows: 2 

foobar 

logmsg 

 

SERVER-SENT EVENTS 

Conventional web applications generate events which are dispatched to the web server. 

For example a simple click on a link requests a new page from the server. 

The type of events which are flowing from web browser to the web server may be called 

client-sent events. 

Along with HTML5, WHATWG Web Applications 1.0 introduces events which flow 

from web server to the web browsers and they are called Server-Sent Events (SSE). 

Using SSE you can push DOM events continuously from your web server to the visitor's 

browser. 

The event streaming approach opens a persistent connection to the server, sending data 

to the client when new information is available, eliminating the need for continuous 

polling. 

 

2.13 Web Socket, Canvas, Audio & Video 

 
WEB SOCKET 

Web Sockets is a next-generation bidirectional communication technology for web 

applications which operates over a single socket and is exposed via a JavaScript 

interface in HTML 5 compliant browsers. 

Once you get a Web Socket connection with the web server, you can send data from 

http://www.whatwg.org/
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browser to server by calling a send () method, and receive data from server to browser 

by an onmessage event handler. 

Following is the API which creates a new WebSocket object. 

var Socket = new WebSocket(url, [protocal] ); 

Here first argument, url, specifies the URL to which to connect. The second attribute, 

protocol is optional, and if present, specifies a sub-protocol that the server must support 

for the connection to be successful. 

 WebSocket Attributes 

Following are the attribute of WebSocket object. Assuming we created Socket object as 

mentioned above − 

Attribute Description 

Socket.readyState The readonly attribute readyState represents the state 

of the connection. It can have the following values − 

 A value of 0 indicates that the connection has 

not yet been established. 

 A value of 1 indicates that the connection is 

established and communication is possible. 

 A value of 2 indicates that the connection is 

going through the closing handshake. 

 A value of 3 indicates that the connection has 

been closed or could not be opened. 

Socket.bufferedAmount The readonly attribute bufferedAmount represents the 

number of bytes of UTF-8 text that have been queued 

using send() method. 

 Web Socket Events 

Following are the events associated with WebSocket object. Assuming we created 

Socket object as mentioned above − 

Event Event Handler  Description 

Open Socket.onopen  This event occurs when socket connection is established. 

message Socket.onmessage  This event occurs when client receives data from server. 

Error Socket.onerror  This event occurs when there is any error in 

communication. 
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Close Socket.onclose  This event occurs when connection is closed. 

 Web Socket Methods 

Following are the methods associated with Web Socket object. Assuming we created 

Socket object as mentioned above − 

Method Description 

Socket.send() The send(data) method transmits data using the connection. 

Socket.close() The close() method would be used to terminate any existing 

connection. 

 Web Socket Example 

A WebSocket is a standard bidirectional TCP socket between the client and the server. 

The socket starts out as a HTTP connection and then "Upgrades" to a TCP socket after a 

HTTP handshake. After the handshake, either side can send data. 

 Client Side HTML & JavaScript Code 

At the time of writing this unit, there are only few web browsers supporting 

WebSocket() interface. You can try following example with latest version of Chrome, 

Mozilla, Opera and Safari. 

<!DOCTYPE HTML> 

<html> 

<head> 

  

<script type="text/javascript"> 

         function WebSocketTest() 

         { 

            if ("WebSocket" in window) 

            { 

               alert("WebSocket is supported by your Browser!"); 

 

               // Let us open a web socket 

               var ws = new WebSocket("ws://localhost:9998/echo"); 

     

               ws.onopen = function() 

               { 

                  // Web Socket is connected, send data using send() 

                  ws.send("Message to send"); 

                  alert("Message is sent..."); 

               }; 
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               ws.onmessage = function (evt)  

               {  

                  var received_msg = evt.data; 

                  alert("Message is received..."); 

               }; 

     

               ws.onclose = function() 

               {  

                  // websocket is closed. 

                  alert("Connection is closed...");  

               }; 

            } 

 

            else 

            { 

               // The browser doesn't support WebSocket 

               alert("WebSocket NOT supported by your Browser!"); 

            } 

         } 

</script> 

   

</head> 

<body> 

 

<div id="sse"> 

<a href="javascript:WebSocketTest()">Run WebSocket</a> 

</div> 

 

</body> 

</html> 

CANVAS 

HTML5 element <canvas> gives you an easy and powerful way to draw graphics using 

JavaScript. It can be used to draw graphs, make photo compositions or do simple (and 

not so simple) animations. 

Here is a simple <canvas> element which has only two specific 

attributes width and height plus all the core HTML5 attributes like id, name and class 

etc. 

<canvas id="mycanvas" width="100" height="100"></canvas> 



               Odisha State Open University Page 45 

 

You can easily find that <canvas> element in the DOM using getElementById() method 

as follows − 

var canvas  = document.getElementById("mycanvas"); 

Let us see a simple example on using <canvas> element in HTML5 document. 

<!DOCTYPE HTML> 

<html> 

<head> 

 

<style> 

         #mycanvas{border:1px solid red;} 

</style> 

 

</head> 

<body> 

 

<canvas id="mycanvas" width="100" height="100"></canvas> 

 

</body> 

</html> 

This will produce following result − 

The Rendering Context 

The <canvas> is initially blank, and to display something, a script first needs to access 

the rendering context and draw on it. 

The canvas element has a DOM method called getContext, used to obtain the rendering 

context and its drawing functions. This function takes one parameter, the type of 

context 2d. 

This unit covers following examples related to HTML5 <canvas> element. 

 

Examples Description 

Drawing Rectangles  Learn how to draw rectangle using HTML5 <canvas> 

element 

Drawing Paths  Learn how to make shapes using paths in HTML5 

<canvas> element 

https://www.tutorialspoint.com/html5/canvas_drawing_rectangles.htm
https://www.tutorialspoint.com/html5/canvas_drawing_paths.htm
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Drawing Lines  Learn how to draw lines using HTML5 <canvas> 

element 

Drawing Bezier Learn how to draw bezier curve using HTML5 

<canvas> element 

Drawing Quadratic Learn how to draw quadratic curve using HTML5 

<canvas> element 

Using Images  Learn how to use images with HTML5 <canvas> 

element 

Create Gradients  Learn how to create gradients using HTML5 <canvas> 

element 

Styles and Colors  Learn how to apply styles and colors using HTML5 

<canvas> element 

Text and Fonts  Learn how to draw amazing text using different fonts 

and their size. 

Pattern and 

Shadow 

Learn how to draw different patterns and drop 

shadows. 

Canvas States  Learn how to save and restore canvas states while 

doing complex drawings on a canvas. 

Canvas Translation This method is used to move the canvas and its origin 

to a different point in the grid. 

Canvas Rotation This method is used to rotate the canvas around the 

current origin. 

Canvas Scaling  This method is used to increase or decrease the units in 

a canvas grid. 

Canvas Transform These methods allow modifications directly to the 

transformation matrix. 

Canvas 

Composition 

This method is used to mask off certain areas or clear 

sections from the canvas. 

https://www.tutorialspoint.com/html5/canvas_drawing_lines.htm
https://www.tutorialspoint.com/html5/canvas_drawing_bezier.htm
https://www.tutorialspoint.com/html5/canvas_drawing_quadratic.htm
https://www.tutorialspoint.com/html5/canvas_using_images.htm
https://www.tutorialspoint.com/html5/canvas_create_gradients.htm
https://www.tutorialspoint.com/html5/canvas_styles_and_colors.htm
https://www.tutorialspoint.com/html5/canvas_text_fonts.htm
https://www.tutorialspoint.com/html5/canvas_pattern_shadow.htm
https://www.tutorialspoint.com/html5/canvas_pattern_shadow.htm
https://www.tutorialspoint.com/html5/canvas_states.htm
https://www.tutorialspoint.com/html5/canvas_translation.htm
https://www.tutorialspoint.com/html5/canvas_rotation.htm
https://www.tutorialspoint.com/html5/canvas_scaling.htm
https://www.tutorialspoint.com/html5/canvas_transform.htm
https://www.tutorialspoint.com/html5/canvas_composition.htm
https://www.tutorialspoint.com/html5/canvas_composition.htm
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Canvas Animation Learn how to create basic animation using HTML5 

canvas and Javascript. 

AUDIO & VIDEO 

HTML5 features include native audio and video support without the need for Flash. 

The HTML5 <audio> and <video> tags make it simple to add media to a website. You 

need to set src attribute to identify the media source and include a controls attribute so 

the user can play and pause the media. 

 Embedding Video 

Here is the simplest form of embedding a video file in your webpage − 

<video src="foo.mp4"  width="300" height="200" controls> 

   Your browser does not support the <video> element.    

</video> 

The current HTML5 draft specification does not specify which video formats browsers 

should support in the video tag. But most commonly used video formats are − 

 Ogg − Ogg files with Thedora video codec and Vorbis audio codec. 

 mpeg4 − MPEG4 files with H.264 video codec and AAC audio codec. 

You can use <source> tag to specify media along with media type and many other 

attributes. A video element allows multiple source elements and browser will use the 

first recognized format − 

<!DOCTYPE HTML> 

<html> 

<body> 

 

<video  width="300" height="200" controls autoplay> 

<source src="/html5/foo.ogg" type="video/ogg" /> 

<source src="/html5/foo.mp4" type="video/mp4" /> 

         Your browser does not support the video element. 

</video> 

 

</body> 

</html> 

This will produce following result − 

 Video Attribute Specification 

The HTML5 video tag can have a number of attributes to control the look and feel and 

various functionalities of the control − 

https://www.tutorialspoint.com/html5/canvas_animation.htm
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Attribute Description 

autoplay This boolean attribute if specified, the video will automatically begin 

to play back as soon as it can do so without stopping to finish loading 

the data. 

autobuffer This boolean attribute if specified, the video will automatically begin 

buffering even if it's not set to automatically play. 

controls If this attribute is present, it will allow the user to control video 

playback, including volume, seeking, and pause/resume playback. 

height This attribute specifies the height of the video's display area, in CSS 

pixels. 

loop This boolean attribute if specified, will allow video automatically 

seek back to the start after reaching at the end. 

preload This attribute specifies that the video will be loaded at page load, and 

ready to run. Ignored if autoplay is present. 

poster This is a URL of an image to show until the user plays or seeks. 

src The URL of the video to embed. This is optional; you may instead use 

the <source> element within the video block to specify the video to 

embed 

width This attribute specifies the width of the video's display area, in CSS 

pixels. 

 Embedding Audio 

HTML5 supports <audio> tag which is used to embed sound content in an HTML or 

XHTML document as follows. 

<audio src="foo.wav" controls autoplay> 

   Your browser does not support the <audio> element.    

</audio> 

The current HTML5 draft specification does not specify which audio formats browsers 

should support in the audio tag. But most commonly used audio formats are ogg, 

mp3 and wav. 

You can use <source> tag to specify media along with media type and many other 

attributes. An audio element allows multiple source elements and browser will use the 

first recognized format − 

<!DOCTYPE HTML> 
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<html> 

<body> 

 

<audio controls autoplay> 

<source src="/html5/audio.ogg" type="audio/ogg" /> 

<source src="/html5/audio.wav" type="audio/wav" /> 

         Your browser does not support the audio element. 

</audio> 

 

</body> 

</html> 

This will produce following result − 

 Audio Attribute Specification 

The HTML5 audio tag can have a number of attributes to control the look and feel and 

various functionalities of the control: 

Attribute Description 

autoplay This boolean attribute if specified, the audio will automatically begin 

to play back as soon as it can do so without stopping to finish loading 

the data. 

autobuffer This boolean attribute if specified, the audio will automatically begin 

buffering even if it's not set to automatically play. 

controls If this attribute is present, it will allow the user to control audio 

playback, including volume, seeking, and pause/resume playback. 

loop This boolean attribute if specified, will allow audio automatically 

seek back to the start after reaching at the end. 

preload This attribute specifies that the audio will be loaded at page load, and 

ready to run. Ignored if autoplay is present. 

src The URL of the audio to embed. This is optional; you may instead use 

the <source> element within the video block to specify the video to 

embed 

 
2.14 Geolocation, Microdata, Drag & drop, Web Workers 

 
GEOLOCATION 
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HTML5 Geolocation API lets you share your location with your favorite web sites. A 

Javascript can capture your latitude and longitude and can be sent to backend web server 

and do fancy location-aware things like finding local businesses or showing your 

location on a map. 

Today most of the browsers and mobile devices support Geolocation API. The 

geolocation APIs work with a new property of the global navigator object i.e. 

Geolocation object which can be created as follows: 

var geolocation = navigator.geolocation; 

The geolocation object is a service object that allows widgets to retrieve information 

about the geographic location of the device. 

 Geolocation Methods 

The geolocation object provides the following methods - 

Method Description 

getCurrentPosition() This method retrieves the current geographic location of 

the user. 

watchPosition() This method retrieves periodic updates about the current 

geographic location of the device. 

clearWatch() This method cancels an ongoing watchPosition call. 

Example 

Following is a sample code to use any of the above method − 

function getLocation() { 

   var geolocation = navigator.geolocation; 

   geolocation.getCurrentPosition(showLocation, errorHandler); 

} 

Here showLocation and errorHandler are callback methods which would be used to get 

actual position as explained in next section and to handle errors if there is any. 

 MICRODATA 

Microdata is a standardized way to provide additional semantics in your web pages. 

Microdata lets you define your own customized elements and start embedding custom 

properties in your web pages. At a high level, microdata consist of a group of name-

value pairs. 

The groups are called items, and each name-value pair is a property. Items and 

properties are represented by regular elements. 

https://www.tutorialspoint.com/html5/geolocation_getcurrentposition.htm
https://www.tutorialspoint.com/html5/geolocation_watchposition.htm
https://www.tutorialspoint.com/html5/geolocation_clearwatch.htm
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Example 

 To create an item, the itemscope attribute is used. 

 To add a property to an item, the itemprop attribute is used on one of the 

item's descendants. 

Here there are two items, each of which has the property "name" − 

<html> 

<body> 
 

<divitemscope> 
<p>My name is <spanitemprop="name">Zara</span>.</p> 

</div> 
 
<divitemscope> 

<p>My name is <spanitemprop="name">Nuha</span>.</p> 
</div> 

 
</body> 
</html> 

DRAG & DROP 

Drag and Drop (DnD) is powerful User Interface concept which makes it easy to copy, 

reorder and deletion of items with the help of mouse clicks. This allows the user to click 
and hold the mouse button down over an element, drag it to another location, and release 

the mouse button to drop the element there. 

To achieve drag and drop functionality with traditional HTML4, developers would 

either have to either have to use complex Javascript programming or other Javascript 
frameworks like jQuery etc. 

Now HTML 5 came up with a Drag and Drop (DnD) API that brings native DnD 
support to the browser making it much easier to code up. 

HTML 5 DnD is supported by all the major browsers like Chrome, Firefox 3.5 and 
Safari 4 etc. 

 Drag and Drop Events 

There are number of events which are fired during various stages of the drag and drop 
operation. These events are listed below − 

Events Description 

dragstart Fires when the user starts dragging of the object. 

dragenter Fired when the mouse is first moved over the target element while a 

drag is occuring. A listener for this event should indicate whether a 

drop is allowed over this location. If there are no listeners, or the 

listeners perform no operations, then a drop is not allowed by default. 
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dragover This event is fired as the mouse is moved over an element when a drag 

is occuring. Much of the time, the operation that occurs during a 

listener will be the same as the dragenter event. 

dragleave This event is fired when the mouse leaves an element while a drag is 

occuring. Listeners should remove any highlighting or insertion 

markers used for drop feedback. 

drag Fires every time the mouse is moved while the object is being dragged. 

drop The drop event is fired on the element where the drop was occured at 

the end of the drag operation. A listener would be responsible for 

retrieving the data being dragged and inserting it at the drop location. 

dragend Fires when the user releases the mouse button while dragging an 

object. 

Note − Note that only drag events are fired; mouse events such as mousemove are not 

fired during a drag operation. 

WEB WORKERS 

JavaScript was designed to run in a single-threaded environment, meaning multiple 

scripts cannot run at the same time. Consider a situation where you need to handle UI 

events, query and process large amounts of API data, and manipulate the DOM. 

Javascript will hang your browser in situation where CPU utilization is high. Let us take 

a simple example where Javascript goes through a big loop − 

<!DOCTYPE HTML> 

<html> 

<head> 

<title>Big for loop</title> 
 

<script> 
         function bigLoop(){ 
            for (var i = 0; i <= 10000; i += 1){ 

               var j = i; 
            } 

            alert("Completed " + j + "iterations" ); 
         } 
 

         function sayHello(){ 
            alert("Hello sir...." ); 

         } 
</script> 
 

</head> 
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<body> 
 

<input type="button" onclick="bigLoop();" value="Big Loop" /> 
<input type="button" onclick="sayHello();" value="Say Hello" /> 

 
</body> 
</html> 

It will produce the following result − 

When you click Big Loop button it displays following result in Firefox − 

 
 

2.15 Web Messaging, Web CORS, Web RTC 

 
WEB MESSAGING 

Web Messaging is the way for documents to separates browsing context to share the 

data without Dom. It overrides the cross domain communication problem in different 

domains, protocols or ports. 

For example you want to send the data from your page to ad container which is placed at 

iframe or voice-versa, in this scenario, Browser throws a security exception. With web 

messaging we can pass the data across as a message event. 

 Message Event 

Message events fires Cross-document messaging, channel messaging, server-sent events 

and web sockets. It has described by Message Event interface. 

Attributes 

Attributes Description 

data Contains string data 

origin Contains Domain name and port 

lastEventId Contains unique identifier for the current message event. 
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source Contains to A reference to the originating document’s window 

ports Contains the data which is sent by any message port 

 Sending a cross-document  message 

Before send cross document message, we need to create a new web browsing context 

either by creating new iframe or new window. We can send the data using with 

postMessage() and it has two arguments. They are as 

 message − The message to send 

 targetOrigin − Origin name 

Examples 

Sending message from iframe to button 

var iframe = document.querySelector('iframe'); 

var button = document.querySelector('button'); 

 

var clickHandler =function(){ 

   iframe.contentWindow.postMessage('The message to  send.',' 

https://www.learningpoint.com); 

} 

button.addEventListener('click',clickHandler,false); 

Receiving a cross-document message in the receiving document 

var messageEventHandler =function(event){ 

// check that the origin is one we want. 

if(event.origin =='https://www.learningpoint.com'){ 

      alert(event.data); 

 } 

} 

window.addEventListener('message', messageEventHandler,false); 

WEB CORS 

Cross-origin resource sharing (CORS) is a mechanism to allows the restricted resources 

from another domain in web browser. 

For suppose, if you click on HTML5- video player in html5 demo sections. It will ask 

camera permission. If user allows the permission then only it will open the camera or 

else it doesn't open the camera for web applications. 

 Making a CORS request 

Here Chrome, Firefox, Opera and Safari all use the XMLHttprequest2 object and 

Internet Explorer uses the similar XDomainRequest object. 

function createCORSRequest(method, url) { 

   var xhr = new XMLHttpRequest(); 

 

https://www/
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   if ("withCredentials" in xhr) { 

      // Check if the XMLHttpRequest object has a "withCredentials" property. 

      // "withCredentials" only exists on XMLHTTPRequest2 objects. 

      xhr.open(method, url, true); 

   } 

 

   else if (typeof XDomainRequest != "undefined") { 

      // Otherwise, check if XDomainRequest. 

      // XDomainRequest only exists in IE, and is IE's way of making CORS 

requests. 

      xhr = new XDomainRequest(); 

      xhr.open(method, url); 

   } 

   else { 

      // Otherwise, CORS is not supported by the browser. 

      xhr = null; 

   } 

   return xhr; 

} 

var xhr = createCORSRequest('GET', url); 

if (!xhr) { 

   throw new Error('CORS not supported'); 

} 

 
Event handles in CORS 

Event Handler Description 

onloadstart Starts the request 

onprogress Loads the data and send the data 

onabort Abort the request 

onerror request has failed 

onload request load successfully 

ontimeout time out has happened before request could complete 

onloadend When the request is complete either successful or failure 

Example of onload or onerror event 

xhr.onload = function() { 
   var responseText = xhr.responseText; 
 

   // process the response. 
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   console.log(responseText); 
}; 

xhr.onerror = function() { 
   console.log('There was an error!'); 

}; 
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WEB RTC 

Web RTC introduced by World Wide Web Consortium (W3C). That supports browser-

to-browser applications for voice calling, video chat, and P2P file sharing. 

Web RTC available for Chrome,opera,and firefox. A good place to start is the simple 

video chat application at here. Web RTC implements three API's as shown below − 

 MediaStream − get access to the user's camera and microphone. 

 RTCPeerConnection − get access to audio or video calling facility. 

 RTCDataChannel − get access to peer-to-peer communication. 

 

2.17 Check Your Progress 

 

1. Answer the following Questions: 

a) What is a XHTML? 

 

____________________________________________________________________ 

b)  How is the page structure of HTML 5 different from HTML 4 or previous 

HTML? 

 

 

 

2.18 Check Your Progress -Possible Answer 

1. a) Extensible Hypertext Markup Language (XHTML) is part of the family of XML 

markup languages. It mirrors or extends versions of the widely used Hypertext 

Markup Language (HTML), the language in which Web pages are formulated. 

 

b)  A typical web page has headers, footers, navigation, central area and side bars. 

Now if we want to represent the same in HTML 4 with proper names to the HTML 

section we would probably use a DIV tag. 

But in HTML 5 they have made it more clearly by creating element names for those 

sections which makes your HTML more readable. 

 

 

http://apprtc.appspot.com/
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Below are more details of the HTML 5 elements which form the page structure. 

<header>: Represents header data of HTML. 

<footer>: Footer section of the page. 

<nav>: Navigation elements in the page. 

<article>: Self-contained content. 

<section>: Used inside article to define sections or group content in to sections. 

<aside>: Represent side bar contents of a page. 

 

2.19 References 

1. www.google.com 

2. www.javapoints.com 

3. www.Tutorialpoints.com 

4. www.w3schools.com 

http://www.javapoints/
http://www.tutorialpoints.com/
http://www.javatpoints/
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UNIT –III XML 

 

Learning objectives:- 

At the end of this unit the students will be able to: 

 Know about XML 

 Know how to display XML on the web 

 Understand the eXtensible Style Sheet Language 

 

STRUCTURE 

 
3.1 Introduction to XML - eXtensible Markup Language 
3.2 XML for data centric files 

3.3 Displaying XML on the web 
3.4 Displaying XML with CSS 

3.5 XSLT - eXtensible Style Sheet Language 
3.6 Displaying XML with XSLT 
3.7 Check your Progress 

3.8 Check your Progress- possible answer 

3.9 References 
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3.1  Introduction to XML - eXtensible Markup Language 
 

XML, or Extensible Markup Language, is a markup language that you can use to create 

your own tags. It was created by the World Wide Web Consortium (W3C) to overcome 

the limitations of HTML, the Hypertext Markup Language that is the basis for all Web 

pages. Like HTML, XML is based on SGML -- Standard Generalized Markup Language. 

Although SGML has been used in the publishing industry for decades, its perceived 

complexity intimidated many people that otherwise might have used it (SGML also 

stands for "Sounds great, maybe later"). XML was designed with the Web in mind. 

There are three important characteristics of XML that make it useful in a variety of 

systems and solutions: 

 XML is extensible: XML allows you to create your own self-descriptive tags, or 

language, that suits your application. 

 XML carries the data, does not present it: XML allows you to store the data 

irrespective of how it will be presented. 

 XML is a public standard: XML was developed by an organization called the 

World Wide Web Consortium (W3C) and is available as an open standard. 

A markup language is a mechanism to identify structures in a document. The XML 

specification defines a standard way to add markup to documents. 

What's a Document? 

The number of applications currently being developed that are based on, or make use 

of, XML documents is truly amazing (particularly when you consider that XML is 

not yet a year old)! For our purposes, the word "document" refers not only to 

traditional documents, like this one, but also to the myriad of other XML "data 

formats". These include vector graphics, e-commerce transactions, mathematical 

equations, object meta-data, server APIs, and a thousand other kinds of structured 

information. 
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Is XML Similar to HTML? 

In HTML, both the tag semantics and the tag set are fixed. An <h1> is always a first 

level heading and the tag <ati.product.code> is meaningless. The W3C, in 

conjunction with browser vendors and the WWW community, is constantly working 

to extend the definition of HTML to allow new tags to keep pace with changing 

technology and to bring variations in presentation (stylesheets) to the Web. However, 

these changes are always rigidly confined by what the browser vendors have 

implemented and by the fact that backward compatibility is paramount. And for 

people who want to disseminate information widely, features supported by only the 

latest releases of Netscape and Internet Explorer are not useful. 

XML specifies neither semantics nor a tag set. In fact XML is really a meta-language 

for describing markup languages. In other words, XML provides a facility to define 

tags and the structural relationships between them. Since there's no predefined tag set, 

there can't be any preconceived semantics. All of the semantics of an XML document 

will either be defined by the applications that process them or by stylesheets. 

Why do we need XML? 

HTML is the most successful markup language of all time. You can view the simplest 

HTML tags on virtually any device, from palmtops to mainframes, and you can even 

convert HTML markup into voice and other formats with the right tools. Given the 

success of HTML, why did the W3C create XML? To answer that question, take a 

look at this document: 

1 

2 
3 
4 

5 

<p><b>Mrs. Mary McGoon</b> 

<br> 
1401 Main Street 
<br> 

Anytown, NC 34829</p> 
  

XML Usage 

A short list of XML usage says it all: 

 XML can work behind the scene to simplify the creation of HTML documents 

for large web sites. 

 XML can be used to exchange the information between organizations and 

systems. 

 XML can be used for offloading and reloading of databases. 
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 XML can be used to store and arrange the data, which can customize your data 

handling needs. 

 XML can easily be merged with style sheets to create almost any desired output. 

 Virtually, any type of data can be expressed as an XML document. 

Is XML a Programming Language? 

A programming language consists of grammar rules and its own vocabulary which is 

used to create computer programs. These programs instructs computer to perform 

specific tasks. XML does not qualify to be a programming language as it does not 

perform any computation or algorithms. It is usually stored in a simple text file and is 

processed by special software that is capable of interpreting XML. 

 Features and Advantages of XML 

XML is widely used in the era of web development. It is also used to simplify data 

storage and data sharing. 

The main features or advantages of XML are given below. 

1) XML separates data from HTML:- 

If you need to display dynamic data in your HTML document, it will take a lot of work to 

edit the HTML each time the data changes. 

With XML, data can be stored in separate XML files. This way you can focus on using 

HTML/CSS for display and layout, and be sure that changes in the underlying data will 

not require any changes to the HTML. 

With a few lines of JavaScript code, you can read an external XML file and update the 

data content of your web page. 

2) XML simplifies data sharing:- 

In the real world, computer systems and databases contain data in incompatible formats. 

XML data is stored in plain text format. This provides a software- and hardware-

independent way of storing data. 

This makes it much easier to create data that can be shared by different applications. 

3) XML simplifies data transport 

One of the most time-consuming challenges for developers is to exchange data between 

incompatible systems over the Internet. 

Exchanging data as XML greatly reduces this complexity, since the data can be read by 
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different incompatible applications. 

4) XML simplifies Platform change 

Upgrading to new systems (hardware or software platforms), is always time consuming. 

Large amounts of data must be converted and incompatible data is often lost. 

XML data is stored in text format. This makes it easier to expand or upgrade to new 

operating systems, new applications, or new browsers, without losing data. 

5) XML increases data availability 

Different applications can access your data, not only in HTML pages, but also from 

XML data sources. 

With XML, your data can be available to all kinds of "reading machines" (Handheld 

computers, voice machines, news feeds, etc), and make it more available for blind 

people, or people with other disabilities. 

6) XML can be used to create new internet languages  

A lot of new Internet languages are created with XML 

 

3.2 XML for data centric files 
 

Data-Centric XML 

By contrast, data-centric XML is used to mark up highly structured information such as 

the textual representation of relational data from databases, financial transaction 

information, and programming language data structures. Data-centric XML is typically 

generated by machines and is meant for machine consumption. It is XML's natural ability 

to nest and repeat markup that makes it the perfect choice for representing these types of 

data. 

Consider the purchase order example in Listing below. It is a purchase order from the 

Skateboard Warehouse, retailer of skateboards to SkatesTown. The order is for 5 

backpacks, 12 skateboards, and 1,000 SkatesTown promotional stickers (this is what the 

stock keeping unit [SKU] of 008-PR stands for). 

Purchase Order in XML 

<po id="43871" submitted="2001-10-05"> 
<billTo> 

<company>The Skateboard Warehouse</company> 
<street>One Warehouse Park</street> 

<street>Building 17</street> 

http://books.gigatux.nl/mirror/buildingwebserviceswithjava/0672321815_ch02lev1sec2.html#ch02list01
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<city>Boston</city> 
<state>MA</state> 

<postalCode>01775</postalCode> 
</billTo> 

<shipTo> 
<company>The Skateboard Warehouse</company> 
<street>One Warehouse Park</street> 

<street>Building 17</street> 
<city>Boston</city> 

<state>MA</state> 
<postalCode>01775</postalCode> 
</shipTo> 

<order> 
<item sku="318-BP" quantity="5"> 

<description>Skateboard backpack; five pockets</description> 
</item> 
<item sku="947-TI" quantity="12"> 

<description>Street-style titanium skateboard.</description> 
</item> 

<item sku="008-PR" quantity="1000"> 
</item> 
</order> 

</po> 

The use of XML is very different from the previous user guide example: 

 The ratio of markup to content is high. The XML includes many different 

types of tags. There is no long-running text. 

 The XML includes machine-generated information; for example, the 

submission date of the purchase order uses a date-time format of year-month-

day. A human authoring an XML document is unlikely to enter a date-time 

value in this format. 

 The tags are organized in a highly structured manner. Order and positioning 

matter, relative to other tags. For example, <description> must be 

under <item>, which must be under <order>, which must be under <po>. 

The <order> tag can be used only once in the document. 

 Markup is used to describe what a piece of information means rather than how 

it should be presented to a human. 

In short, if you can easily imagine the XML as a data structure in your favorite 

programming language, you are probably looking at a data-centric use of XML. An 

example Java class that could, with a bit more work, be used to represent the purchase 

order data is shown here: 

class PO 
{ 
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    int id; 
    Date submitted; 

    Address billTo; 
    Address shipTo; 

    Item order[]; 
} 

 

3.3 Displaying XML on the web 

  

XML Documents Must Have a Root Element 

XML documents must contain one root element that is the parent of all other elements: 

<root> 
  <child> 
    <subchild>.....</subchild> 

  </child> 
</root> 

In this example <note> is the root element: 
<?xml version="1.0" encoding="UTF-8"?> 
<note> 

  <to>Tove</to> 
  <from>Jani</from> 

  <heading>Reminder</heading> 
  <body>Don’t</body> 
</note> 

 The XML Prolog 

This line is called the XML prolog: 

<?xml version="1.0" encoding="UTF-8"?> 

 The XML prolog is optional. If it exists, it must come first in the document. 

 XML documents can contain international characters, like Norwegian øæå or 

French êèé. To avoid errors, you should specify the encoding used, or save your 

XML files as UTF-8. 

 UTF-8 is the default character encoding for XML documents. 

 UTF-8 is also the default encoding for HTML5, CSS, JavaScript, PHP, and SQL. 

 All XML Elements Must Have a Closing Tag 

 In HTML, some elements might work well, even with a missing closing tag: 
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e.g  <p>This is a paragraph. 

<br> 

 In XML, it is illegal to omit the closing tag. All elements must have a closing tag: 

e.g   <p>This is a paragraph.</p> 

<br /> 

 The XML prolog does not have a closing tag. 

This is not an error. The prolog is not a part of the XML document. 

 XML Tags are Case Sensitive 

 XML tags are case sensitive. The tag <Letter> is different from the tag <letter>. 

 Opening and closing tags must be written with the same case: 

e.g  <Message>This is incorrect</message> 

<message>This is correct</message> 

 "Opening and closing tags" are often referred to as "Start and end tags". Use 

whatever you prefer. It is exactly the same thing. 

 XML Elements Must be Properly Nested 

 In HTML, you might see improperly nested elements: 

e.g. <b><i>This text is bold and italic</b></i> 

 In XML, all elements must be properly nested within each other: 

e.g. <b><i>This text is bold and italic</i></b> 

 In the example above, "Properly nested" simply means that since the <i> element 

is opened inside the <b> element, it must be closed inside the <b> element. 

 XML Attribute Values Must be Quoted. 

 XML elements can have attributes in name/value pairs just like in HTML. 

 In XML, the attribute values must always be quoted. 

INCORRECT: 

<note date=12/11/2007> 

  <to>Tove</to> 
  <from>Jani</from> 
</note> 

CORRECT: 
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<note date="12/11/2007"> 
  <to>Tove</to> 

  <from>Jani</from> 
</note> 

The error in the first document is that the date attribute in the note element is not quoted. 

 Entity References 

 Some characters have a special meaning in XML. 

 If you place a character like "<" inside an XML element, it will generate an 

error because the parser interprets it as the start of a new element. 

 This will generate an XML error: 

<message>salary < 1000</message> 

 To avoid this error, replace the "<" character with an entity reference: 

<message>salary &lt; 1000</message> 

There are 5 pre-defined entity references in XML: 

&lt; < less than 

&gt; > greater than 

&amp; & ampersand  

&apos; ' apostrophe 

&quot; " quotation mark 

Only < and & are strictly illegal in XML, but it is a good habit to replace > with &gt; as 
well. 

 Comments in XML 

The syntax for writing comments in XML is similar to that of HTML. 
<!-- This is a comment --> 

Two dashes in the middle of a comment are not allowed. 

Not allowed: 
<!-- This is a -- comment --> 

Strange, but allowed: 
<!-- This is a - - comment --> 
 Displaying XML 

Raw XML files can be viewed in all major browsers. 
Don't expect XML files to be displayed as HTML pages. 

Viewing XML Files 

<?xml version="1.0" encoding="UTF-8"?> 
 - <note> 

       <to>Tove</to> 
       <from>Jani</from> 
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       <heading>Reminder</heading> 
       <body>Don't forget me this weekend!</body> 

   </note> 

 Most browsers will display an XML document with color-coded elements. 

 Often a plus (+) or minus sign (-) to the left of the elements can be clicked to 

expand or collapse the element structure. 

 To view raw XML source, try to select "View Page Source" or "View Source" 

from the browser menu. 

 Note: In Safari 5 (and earlier), only the element text will be displayed. To view 

the raw XML, you must right click the page and select "View Source". 

 Viewing an Invalid XML File 

If an erroneous XML file is opened, some browsers will report the error, and some will 

display it, or display it incorrectly. 

<?xml version="1.0" encoding="UTF-8"?> 
 - <note> 

       <to>Tove</to> 
       <from>Jani</Ffrom> 
       <heading>Reminder</heading> 

       <body>Don't forget me this weekend!</body> 
   </note> 

 

3.4 Displaying XML with CSS 
 

Below is an example of how to use CSS to format an XML document. 

 We can use an XML file like cd_catalog.xml and a style sheet like cd_catalog.css 

 RESULT: The CD catalog formatted with the CSS file 

 Below is a fraction of the XML file. The second line links the XML file to the 

CSS file: 

<?xml version="1.0" encoding="UTF-8"?> 

<?xml-stylesheet type="text/css" href="cd_catalog.css"?> 
<CATALOG> 

  <CD> 
    <TITLE>Empire Burlesque</TITLE> 
    <ARTIST>Bob Dylan</ARTIST> 

    <COUNTRY>USA</COUNTRY> 
    <COMPANY>Columbia</COMPANY> 

    <PRICE>10.90</PRICE> 
    <YEAR>1985</YEAR> 
  </CD> 

  <CD> 
    <TITLE>Hide your heart</TITLE> 

    <ARTIST>Bonnie Tyler</ARTIST> 
    <COUNTRY>UK</COUNTRY> 
    <COMPANY>CBS Records</COMPANY> 

    <PRICE>9.90</PRICE> 
    <YEAR>1988</YEAR> 

  </CD> 

javascript:void(0)
https://www.w3schools.com/xml/cd_catalog.css
https://www.w3schools.com/xml/cd_catalog_with_css.xml
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. 
</CATALOG> 

 Formatting XML with CSS is not recommended. Use JavaScript or XSLT 
instead. 

 

 3.5   XSLT - eXtensible Style Sheet Language 
 

XSL 

Before learning XSLT, we should first understand XSL which stands for 

EXtensible Style sheet Language. It is similar to XML as CSS is to HTML. 

 Need for XSL 

In case of HTML document, tags are predefined such as table, div, and span; and the 

browser knows how to add style to them and display those using CSS styles. But in case 

of XML documents, tags are not predefined. In order to understand and style an XML 

document, World Wide Web Consortium (W3C) developed XSL which can act as XML 

based Style sheet Language. An XSL document specifies how a browser should render 

an XML document. 

Following are the main parts of XSL − 

 XSLT − used to transform XML document into various other types of document. 

 XPath − used to navigate XML document. 

 XSL-FO − used to format XML document. 

What is XSLT ? 

XSLT, Extensible Style sheet Language Transformations, provides the ability to 

transform XML data from one format to another automatically. 

How XSLT Works? 

An XSLT style sheet is used to define the transformation rules to be applied on the 

target XML document. XSLT style sheet is written in XML format. XSLT Processor 

takes the XSLT style sheet and applies the transformation rules on the target XML 

document and then it generates a formatted document in the form of XML, HTML, or 

text format. This formatted document is then 

utilized by XSLT formatter to generate the 

actual output which is to be displayed to the 

end-user. 
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 Advantages of using XSLT − 

 Independent of programming. Transformations are written in a separate xsl 

file which is again an XML document. 

 Output can be altered by simply modifying the transformations in xsl file. No 

need to change any code. So Web designers can edit the style sheet and can 

see the change in the output quickly. 

 

3.6 Displaying XML with XSLT  
 

Let’s suppose we have the following sample XML file, students.xml, which is required 

to be transformed into a well-formatted HTML document. 
students.xml 

<?xml version ="1.0"?> 
<class> 
<studentrollno="393"> 

<firstname>Dinkar</firstname> 
<lastname>Kad</lastname> 

<nickname>Dinkar</nickname> 
<marks>85</marks> 
</student> 

<studentrollno="493"> 
<firstname>Vaneet</firstname> 

<lastname>Gupta</lastname> 
<nickname>Vinni</nickname> 
<marks>95</marks> 

</student> 
<studentrollno="593"> 

<firstname>Jasvir</firstname> 
<lastname>Singh</lastname> 
<nickname>Jazz</nickname> 

<marks>90</marks> 
</student> 

</class> 

We need to define an XSLT style sheet document for the above XML document to meet 
the following criteria − 

 Page should have a title Students. 
 Page should have a table of student details. 

 Columns should have following headers: Roll No, First Name, Last Name, Nick 
Name, Marks 
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 Table must contain details of the students accordingly. 

Step 1: Create XSLT document 

Create an XSLT document to meet the above requirements, name it as students.xsl and 
save it in the same location where students.xml lies. 

students.xsl 

<?xml version ="1.0" encoding ="UTF-8"?> 
<!-- xsl stylesheet declaration with xsl namespace:  

Namespace tells the xlst processor about which  
element is to be processed and which is used for output purpose only  

--> 
<xsl:stylesheetversion="1.0" 
xmlns:xsl="http://www.w3.org/1999/XSL/Transform"> 

<!-- xsl template declaration:   
template tells the xlst processor about the section of xml  

document which is to be formatted. It takes an XPath expression.  
In our case, it is matching document root element and will  
tell processor to process the entire document with this template.  

--> 
<xsl:templatematch="/"> 

<!-- HTML tags  
         Used for formatting purpose. Processor will skip them and browser  
            will simply render them.  

      --> 
   

<html> 
<body> 
<h2>Students</h2> 

     
<tableborder="1"> 

<trbgcolor="#9acd32"> 
<th>Roll No</th> 
<th>First Name</th> 

<th>Last Name</th> 
<th>Nick Name</th> 

<th>Marks</th> 
</tr> 
     

<!-- for-each processing instruction  
               Looks for each element matching the XPath expression  

               --> 
     
<xsl:for-eachselect="class/student"> 

<tr> 
<td> 

<!-- value-of processing instruction  
                        process the value of the element matching the XPath expression  
                        --> 

<xsl:value-ofselect="@rollno"/> 
</td> 
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<td><xsl:value-ofselect="firstname"/></td> 

<td><xsl:value-ofselect="lastname"/></td> 
<td><xsl:value-ofselect="nickname"/></td> 

<td><xsl:value-ofselect="marks"/></td> 
       
</tr> 

</xsl:for-each> 
      

</table> 
</body> 
</html> 

</xsl:template> 
</xsl:stylesheet> 

Step 2: Link the XSLT Document to the XML Document 

Update student.xml document with the following xml-stylesheet tag. Set href value to 
students.xsl 

<?xml version ="1.0"?> 

<?xml-stylesheet type ="text/xsl" href ="students.xsl"?> 
<class> 

...  
</class> 

Step 3: View the XML Document in Internet Explorer 

students.xml 

<?xml version ="1.0"?> 
<?xml-stylesheet type ="text/xsl" href ="students.xsl"?> 

<class> 
<studentrollno="393"> 
<firstname>Dinkar</firstname> 

<lastname>Kad</lastname> 
<nickname>Dinkar</nickname> 

<marks>85</marks> 
</student> 
<studentrollno="493"> 

<firstname>Vaneet</firstname> 
<lastname>Gupta</lastname> 

<nickname>Vinni</nickname> 
<marks>95</marks> 
</student> 

<studentrollno="593"> 
<firstname>Jasvir</firstname> 

<lastname>Singh</lastname> 
<nickname>Jazz</nickname> 
<marks>90</marks> 

</student> 
</class> 

Output 



               Odisha State Open University Page 73 

 

 
 

 

3.7 Check Your Progress 

 

1. Answer the following Questions: 

c) What is XML? 

 

____________________________________________________________________ 

b)  What are the benefits of XML? 

 

 

3.8 Check Your Progress -Possible Answer 

1. 

a) XML stands for eXtensible Markup Language. It is a simple and flexible markup 

language. It is known as universal language for data on the web because XML 

documents can be created and used in any language. It is universal standard for 

information interchange. 

 

b) These are the main benefits of using XML. 

Simplicity: Very easy to read and understand the information coded in XML. 

Openness: It is a W3C standard, endorsed by software industry market leaders. 
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Extensibility: It is extensible because it has no fixed set of tags. You can define 

them as you need. 

Self-descriptive: XML documents do not need special schema set-up like traditional 

databases to store data. XML documents can be stored without such definitions, 

because they contain metadata in the form of tags and attributes. 

Scalable: XML is not in binary format so you can create and edit files with anything 

and it is also easy to debug. 

Fast access: XML documents are arranged in hierarchical form so it is comparatively 

faster. 

 

3.9 References 

1. www.google.com 

2. www.w3schools.com 

3. www.Tutorialpoints.com 

 
 

 
 
 

 

http://www.w3schools/
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UNIT –IV 

MACROMEDIA FLASH  
 

Learning objectives:- 

At the end of this unit the students will be able to: 

 Know about macromedia flash. 

 Know how to start flash 

 Know flash tools 

 Understand tools panel 

 Understand how to create flash document. 

 Know animation of text and objects 

STRUCTURE 

 

4.1 What is flash? 

4.2 Starting of flash 

4.3 The workspace 

4.4 Using the Tools panel 

4.5 Selection Tool 

4.6 Coloring Tool 

4.7 Text Tool 

4.8 Create a new Flash Document 

4.9 Symbols and Animation 

4.10 Crate a Motion Tween 

4.11 Shape Tween 

4.12 Motion Guide Tween 

4.13 Working with layers 

4.14 Summary  

4.15 Check your Progress 

4.16 Check your Progress- possible answer 

4.17 References 
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4.1 What is flash? 

 
Flash is an animation software package. Flash provides a versatile and easy way to create 

animation. We can make any objects in flash with animation and make movies with 

sound and action. Flash is one of the most popular technologies on the internet because it 

does not require programming skills. The animation and graphics created in flash can be 

scaled to any size without losing clarity or quality.  

 

4.2 Starting Flash 
 

Starting of Flash 

Step 1 : Click on Start button 

Step 2  : Choose All Programs 

Step 3 : Click on Macromedia  

Step 4 : Select on Macromedia 

Flash8 

The opening screen appears: 

Select the Flash Document under 

Create New selection to open a file. 

 

4.3 The Workspace 
 

1. The stage: This is the rectangular workspace area where we place our contents or 

create our drawing or movie. By default, the Stage size in flash is 550 x 400 

pixels. 

2. Menu: The Menu contains controls for common functions and commands such as 

opening and saving files etc. 

3. The Tools Panel: It contains set of tools to draw, paint, select, and modify 

objects in the workspace. 

4. Timeline: The Timeline is a fixed window that stays on top of every object in the 

workspace. This is the area where graphics and elements are assembled in 

sequential order allowing the user to view the order of events in sequence. 

5. The Properties panel: The Properties Panel is a combination of various elements 

used for changing the settings like the Stage size, the ruler unit, the background 

color of the Stage and the Frame rate. 
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If the Properties Panel is not visible, then we can select the 

windowspropertiesproperties option. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.4 Using Tools panel  
 

The Tools Panel consists of many tools that help in drawing, coloring and modifying an 

object. With the help of tools, we can create a shape like: rectangle, circle, line or any 

other objects. Most of the tools work similar as in MS Paint. 

OVAL TOOL 

 This tool is used to draw oval or circular objects on the Stage. 

 Select the Oval Tool  

 In the Property Inspector, select the properties for the stroke such as line, color, 

thickness and style. 

 Select the Fill Color Tool and choose any color of your choice. Move the pointer 

on the Stage. Hold down the left mouse button and drag it on the Stage. 

 Release the mouse button.You will get a circle on the Stage that consists of Pill 
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and Stroke colors. 

RECTANGLE TOOL 

 This tool is used to create square and rectangular shapes. This tool has an option 

which can rounded rectangle. 

 Select the Rectangle Tool         Hold and drag the mouse pointer on the 

rectangular shape is created, release the left mouse button. 

 To draw the rounded rectangle, select Set Corner Radius tool from the options 

selection. The Rectangle Settings dialog box appears. Enter any number from O 

to 99 in the Corner radius box. Click OK. 

 Now, draw a rectangle on the Stage. You will get a rounded rectangle with the 

specified corner settings. 

POLYSTARTOOL 

This tool is used to draw polygon and star figures. 

 Select he drop-down menu of the Rectangle 

Tool. �twill display a fly out menu. 

 Select the PolyStar tool 

 In the properties inspector, click the option 

button you will get the tool settings dialog box. Click the drop down list of 

Style option and select the star style.  

 Enter the number of sides. Enter the value from 3 to 32 for number of 

sides. 

 For star point size, enter the number between 0 and 1 to specify the depth 

of the star points. A number closer to 0 creates deeper points. 

 Click OK to close the Tool Settings dialog box. 

 Click and drag the pointer on the Stage to draw a star. 

 Similarly, you can draw a polygon by selecting Polygon option in the 

Style text box. 

LINE TOOL  

 The Line Tool / works exactly the same way as the Line tool in graphics software. 

We can use Line tool to draw straight lines.  

 Click the Line Tool / .  

 In the Property Inspector panel. Select the color, thickness or line style as needed 

from the order of events in sequence. 

 Move the pointer on the Stage. 

 Click and drag it in the direction / where you want to draw a line. 

 Release the mouse button. You will get a line on the stage. 
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CURVING  

 You can turn a straight line into a curve with the Selection Tool. 

 After drawing a line, click the Selection Tool (Make sure the line is not selected.) 

 Move the pointer on the line. When the pointer changes toarrow with curve 

symbol, click and drag the line to draw a curve. 

 Release the mouse button when the curve is made. 

 

PEN TOOL 

 Tis tool is used to draw precise paths as straight line or smooth, flowing curves. 

we can also adjust the angle and length of the straight segments and the slope of 

curve segments afterwards. 

 Select the Pen Tool 

 Click on the Stage to define the anchor A. 

 Click to create the second anchor Point Bat a distance. 

a) To complete an open path, double-click the last point or click the Pen Tool in the 

tools panel. 

 

b) To close a path, position the pen tool over the first anchor point. A small circle 

appears next to the Pen tip when it is placed correctly. Click or drags close the 

path. Flash automatically fills the path once it becomes a closed outline. 

 

PENCIL TOOL 

It is a freehand drawing tool. This tool helps to draw lines in three different modes: 

Straighten, Smooth and ink. 

 Select the Pencil Tool 

 Select a stroke color, line weight and style from the Property Inspector Panel and 

draw lines. 

 Straighten: the default option is straighten, straighten mode automatically 

straightens the line drawn by the pencil tool. 

 Smooth: Smooth mode smoothens the jerks on the edges. 

 Ink: ink mode helps in freehand drawing with no modification applied. 

4.5 Selection Tool 
 

SELECTION TOOL 

 This tool is used to select a single or multiple objects on the stage . There are 

different ways to select different properties of an object. 
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 To select a Stroke fill, text block or group, select this tool and click on the object. 

We can select the filled shape and its outline either by dragging a square selection 

box around the object or by double clicking the fill. 

 

LASSO TOOL 

This is a free hand selection tool. We can use this tool to select irregulars saped 

areas of a drawing or a part of an object) This tool has 3 options. 

 Click the Lasso Tool  

 Move the pointer over the Stage area. It changes to Lasso shape. 

 Click and drag the Lasso around the object until we reach the point where we 

started. 

 Release the mouse button. 

SUB SELECTION TOOL 

This tool is used to select the nodes of an object. 

 After selecting this tool, click on an object. Its nodes will appear. 

 You can change an object's shape using the nodes. 

4.6 Coloring Tool 
 

BRUSH TOOL  

It can be used just like a brush on a canvas. You can paint a shape with the desired colour 

using the Brush Tool .You can specify the brush mode, by selecting a brush size and 

shape using the brush tool modifiers.  Some   of the options that are available with Brush 

tool are as follows: 

1. Paint normal - Paint over lines and fills. 

2. Paint files - Fills an empty areas leaving lines unaffected. 

3. Paint behind - Paints blank areas of the Stage leaving line and fills unaffected. 

4. Paint selection- Applies a new fill to the s�ion. 

5. Paint inside – Paints only the fills and doesn't allow you to paint outside the 

lines. 

PAINT BUCKET TOOL 

This tool is useful to fill enclosed areas of an object with colors in a single click. You can 

also use the Pair Bucket tool to fill the areas that are not completely closed. It also 

provides modifiers to close gaps in shape outlines 

To fill color in an object, follow these steps:  

 Select the Paint Bucket Tool. 
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 Click the Fill Color drop-down arrow.  The color palette appears. 

 Select any color of your choice and click inside the object. 

INK BOTTLE TOOL 

It is used to change the stroke color, width and style of lines or shape outlines. 

 Select the Ink Bottle Tool 

 Choose the Stroke color, style and thickness of lines or shape outline from the 

Property Inspector. 

 Click on the line of the drawn object using the Ink Bottle Tool to apply a different 

property to the stroke. 

 The shortcut for Ink Bottle tool is S and for Paint Bucket tool is K. 

ERASER TOOL 

"This tool helps us to erase lines and fills of an object from the Stage 

 Select the Eraser Tool 

 Click on the Eraser Mode Modifier and select the required eraser. 

 Click on the Eraser Shape Modifier and select the eraser shape and size. 

 Click and drag on the object to erase. 

The different erase mode modifiers are as follows:  

1. Eraser Normal - Erase all lines and fills wherever the eraser is 

moved. 

2. Erase Fills - Only erases the fill colors while lines are unaffected. 

3. Erase lines - It is used to erase the strokes only. 

4. Erase Selected Fills- Helps in erasing a selected part of the object. 

5. Erases the inner part of an object. 

4.7 Text Tool 
 

This tool is used to type on the screen. It allows you to add text in your drawing and 

animations. 

 Select the Text Tool 

 Change the color, font, font size, etc. from the Property Inspector 

 Click on any area of the Stage to get the cursor and type the text. 

 Move and adjust the text box in the same way as we move the objects. 

4.8 Create New Flash Document 
 

CREATING A NEW FLASH DOCUMENT 
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 Select File New. The New Document dialog box is displayed. 

 Select the option in the Type list. 

 Click OK. Anew Flash document will open. 

 Select Modify  Document. The Document Properties dialog box 

appears change the background color, frame rate or stage size as per 

your choice. 

4.9 Symbols and Animation 
 

A symbol is a graphic, button, or movie clip that you create in Macromedia Flash Basic 8 

or Macromedia Flash Professional 8.  

You create the symbol only once; you can then reuse it throughout your document or in 
other documents. A symbol can include artwork that you import from another 

application. Any symbol that you create automatically becomes part of the library for the 
current document.  

Creating symbols 

You can create a symbol from selected objects on the Stage, or you can create an empty 
symbol and make or import the content in symbol-editing mode. You can also create font 
symbols in Flash. See creating font symbols. Symbols can have all the functionality that 

you can create with Flash, including animation.  

By using symbols that contain animation, you can create Flash applications with a lot of 
movement while minimizing file size. Consider creating animation in a symbol when 

there is a repetitive or cyclic action--the up-and-down motion of a bird's wings, for 
example. 

You can also add symbols to your document by using shared library assets during 
authoring or at runtime 

Adding animation to a timeline 

You create an animation in a Flash document by adding content to a timeline, such as the 
main timeline, or a timeline inside a movie clip. When the play head moves across the 
Timeline, those individual frames play and when played in quick succession (like a 

flipbook or succession of frames on a reel of film), you can create an animation. 

When you create a frame-by-frame animation, every frame is a key frame. In a twined 
animation, you define key frames at significant points in the animation and let Flash 

create the contents of frames in between. Flash displays the interpolated frames of a 
tweened animation as light blue or light green with an arrow drawn between key frames. 
Because Flash documents save the shapes in each key frame, you should create key 

frames only at the points in the animation where something changes.  

file:///F:/ProgramData/Macromedia/Flash%208/en/Configuration/HelpPanel/Help/UsingFlash/00000527.html%2371545
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1. Select Modify > Document.  

The Document Properties dialog box opens. This is the dialog box you used to 
change the dimensions of the banner in Part 1 of this unit. Now you want to 

change the frame rate for the banner. 

2. Change the number in the frame rate text box to 18, and then click OK to apply 
the new setting.  

A higher frame rate means that your animation plays smoothly, more so than 

when you had it set to 12 frames per second (fps). Changing the fps setting means 
that the main timeline and movie clip timelines all play at the specified frame 

rate. 

NOTE 
 

An increased frame rate also means that there is a slightly increased 
demand on the user's computer (or CPU) to render the extra frames each 
second. 

3. Double-click the join us symbol instance on the Stage.  

This opens the symbol in symbol-editing mode (see the following figure). In this 
mode, you see the movie clip symbol's timeline, which runs independently of the 
timeline for the main FLA file (the one you saw before double-clicking the 

symbol). This means you can have animations that play and stop independently 
from animations on the main timeline. Remember that a movie clip still plays at 

the document's frame rate (18 fps). 

 

In symbol-editing mode, the symbol that you're editing appears normal, while 
other items on the Stage are dimmed. Changes that you make in this mode apply 

to every instance of the symbol in your FLA file. Notice how the edit bar (above 
the Timeline in this figure) changes to show you what you're editing, and its 
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relation to the main Stage. 

 

When you enter this mode, it means you edit the symbol itself, not just the single 
instance on the Stage. Any changes you make on this timeline (which is the 

movie clip's timeline) apply to every instance of the symbol that you use in the 
FLA file. 

You can tell that you're editing a symbol by looking at the edit bar (see the top of 

the previous image). Use the edit bar to navigate throughout a document. The edit 
bar might be above or below the Timeline, depending on how you have the 
workspace set up. 

Scene 1 refers to the main timeline of the FLA file. You can click this button on 

the edit bar to return to the main timeline. The names after it point to the symbol 
that you're editing. If the symbol is nested within other symbols, this path might 

contain several names. In the previous figure, you can see that you're editing the 
join us symbol that's on the main timeline (Scene 1). 

4. Select the PNG file that's inside the movie clip, and then press F8 to convert it 
into another symbol.  

5. In the Convert to Symbol dialog box, type the name nested mc in the Name text 
box, select Movie clip, and click OK.  

6. Select Frame 15 and select Insert > Timeline > Key frame.  

NOTE 
 
Press F6 to quickly insert a new key frame. 

7. This command inserts a new key frame, which means you can modify the content 
on that frame to create animation. Currently, the content on Frame 15 is 

duplicated from the content on Frame 1. When you modify Frame 15 in a future 
step, the modifications won't change the content on Frame 1. 

8. Select Frame 30 and press F6 to insert a new key frame.  

The key frame duplicates the content from Frame 15. That means the content on 

all three frames is the same. 

9. Select the movie clip instance on Frame 15, and open the Property inspector 
(Window > Properties > Properties).  

NOTE 
 

Make sure you select the instance on Frame 15, not just the frame. You 

can first select the frame on the Timeline (or move the play head to Frame 
15), and then select the movie clip instance on the Stage in order to see the 

correct context of the Property inspector, as shown in the following figure. 

10. Select Brightness from the Color pop-up menu (the following figure).  
11. Change the slider value to 75% (see the following figure).  
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Change the brightness of the movie clip instance. 

The brightness changes for the instance on Frame 15. The instances on Frames 1 
and 30 do not change. This means that you can now add a motion tween that 

animates the brightness value between Frames 1 and 15, and then from Frames 15 
to 30. After playing Frame 30, the playhead loops back to Frame 1 and the 
animation starts again. 

NOTE 
 

You could also change the alpha or tint values using the same procedure. 

Alpha tweens are more processor intensive than tweens that change the 
brightness or tint of your animation. Try to avoid processor-intensive 

procedures whenever possible. 

12. Select the instance on the Stage at Frame 15 again, and then select the Free 
Transform tool in the Tools panel. Select the lower right handle and drag it 
towards the center of the image to make it smaller (see the following figure).  

 

Resize the instance using the Free Transform tool. As shown in this figure, you 
can also rotate the image using the Free Transform tool. 

 

You can create several kinds of animation in an FLA file, such as motion tweens, 
shape tweens, and frame-by-frame animation. In this unit, you will create a 

motion tween. A motion tween is an animation where you define properties such 
as position, size, and rotation for an instance at one point in time, and then you 
change those properties at another point in time. In this animation, you change the 

brightness and size of the instance. 
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13. Select any frame between Frames 1 and 15, and then select Motion from the 
Tween pop-up menu in the Property inspector.  

The span of frames changes color and an arrow appears between Frames 1 and 15 

(see the following figure). Notice how the options in the Property inspector are 
different when you select a frame compared to when you select a movie clip 

instance. 

 

Create a motion tween between Frames 1 and 15 on the movie clip's timeline. 

NOTE 
 

You can also right-click (Windows) or option-click (Macintosh) the frame 

and select Create Motion Tween from the context menu instead. 

14. Select any frame between Frames 15 and 30, and then select Motion from the 
Tween pop-up menu in the Property inspector to create a second animation.  

15. Click the play head and drag it across the movie clip's timeline to test (or scrub) 

the animation.  
16. Select Control > Test Movie.  

NOTE 
 

A quicker way to test your SWF file is to use keyboard shortcuts. Press 

Control + Enter (Windows) or Command + Return (Macintosh) to test the 
file 

17. The test environment opens where you can see the animation. Notice how it 
loops, appearing to fade in and out because of the change in brightness. By 
default, the play head returns to Frame 1 and replays the animation after it reaches 
the final frame on the Timeline. This means the animation loops repeatedly, 

unless you tell it to stop. You will find out how to do this below in the exercise 
called writing simple actions. 

18. Select File > Save to save your progress before moving on.  

After you finish saving the file, proceed to the following exercise, Creating a 
button.  

4.10 Create a Motion Tween 
 

You create a motion tween by defining properties for an instance, a grouped object, or 

text in a starting key frame, and then changing the object's properties in a subsequent key 
frame. Flash creates the animation from one key frame to the next in the frames between 

the key frames. 

To create a motion tween, you'll take an instance of a tire symbol and make it appear to 

file:///F:/ProgramData/Macromedia/Flash%208/en/Configuration/HelpPanel/Help/Tutorials/00000135.html%23204602
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bounce. 

1. In the Timeline (Window > Timeline), double-click the Layer 1 title and type 
TireAnim. Press Enter (Windows) or Return (Macintosh) to rename the layer.  

2. With the TireAnim layer still selected, drag the Tire movie clip from the Library 
window (Window > Library) to the Stage, positioning it above the tire shadow.  

3. Use the Selection tool to reposition the tire, if necessary.  

 

4. With the Selection tool still selected, in the TireAnim layer, select Frame 30. 
Then press F6 to insert a keyframe.  

5. Select Frame 15 and press F6 to add another keyframe.  
6. With the playhead still on Frame 15, press Shift to move the tire in a straight line, 

and drag the tire up.  

 

7. In the TireAnim layer, select any frame between Frames 2 and 14. In the Property 

inspector, select Motion from the Tween pop-up menu.  

An arrow appears in the Timeline between the two keyframes.  

8. Select any frame between Frames 16 and 29. Again, use the Tween pop-up menu 
in the Property inspector to select Motion.  

9. Select File > Save to save your changes.  

4.11Shape Tween 
 

With shape tweening, you specify attributes for a shape in one keyframe, and then 
modify the shape or draw another shape in a subsequent keyframe. As with motion 

tweening, Flash creates the animation in the frames between the keyframes. 

You'll now set up a tween for the tire's shadow so that as the tire bounces, the shadow 
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moves and fades. 

1. Click the ShadowAnim layer to select it.  
2. Select Frame 30 and press F6 to insert a keyframe; then select Frame 15 and press 

F6 to insert a keyframe.  
3. With the playhead on Frame 15, select the Selection tool. Drag the tire shadow 

slightly up and to the right.  

 

4. With Frame 15 still selected, select the Eyedropper tool in the Tools panel, and 
then click the shadow object.  

5. If the Color Mixer is not already open, select Window > Color Mixer to open it, 
and change the Alpha value from 25% to 10%.  

 

6. Click the pop-up menu control in the upper-right side of the Color Mixer and 
select Close Panel.  

7. Select any frame between Frames 2 and 14 on the ShadowAnim layer. In the 
Property inspector, select Shape from the Tween pop-up menu.  

8. On the ShadowAnim layer, select any frame between Frames 16 and 29. Again, 

use the Tween pop-up menu in the Property inspector to select Shape.  

4.12Motion Guide Tween 
 

To create a motion tween in the new frames: 

1. Select Frame 61 of the layer named Ball.  
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2. Select Insert > Timeline > Key frame.  

 

The keyframe added in Frame 61 of the Timeline 

3. On the Stage, press Shift and drag the eight ball downward until the bottom of the 
eight ball is in the middle of the shadow graphic.  

 

The eight ball correctly placed on the shadow 

You have now defined a new position for the eight ball on the Stage in Frame 61. 
The ball now has one position for the first 60 frames, and a different position for 

the keyframe in Frame 61. When you define the motion tween, Flash calculates 
the positions in each frame for the eight ball, that is, between its original position 
above the Stage and its final position in the middle of the shadow. 

4. In the Timeline, click the Ball layer name. This selects all the frames in that layer.  

5. In the Property inspector, select Motion from the Tween menu. This applies the 
motion tween to the selected frames.  
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The Motion selected in the Tween menu of the Property inspector 

6. In the Timeline, drag the playhead from Frame 1 to Frame 61. You will see the 
eight ball animate downward towards the shadow graphic.  

NOTE 
 

The speed of the ball's motion is constant throughout the animation. In the 

next section you will learn to control the speed with which your 
animations begin and end their motion. 

7. Select File > Save As.  
8. Name the file my_tween_start.fla and click OK.  

4.13 Working with Layers 

Introducing layers and the timeline 

The Timeline is above the Stage in the Flash workspace. The Timeline, which contains 
layers and frames, helps you organize assets in your document, and also controls a 

document's content over time.  

Flash documents can play over a length of time, like movies or sound, which is measured 
using frames. Layers are like transparencies that stack on top of one another, and each 
layer can contain images, text, or animations that display on the Stage.  

The FLA file you're working on has one layer (Layer 1) with contents on a single frame 
(Frame 1). This is the default way that a Flash document opens.  

In this exercise, you lock and rename Layer 1. Often you'll want to place objects in a 
particular position on the Stage. To help you keep those objects in place, Flash enables 

you to lock layers, so you cannot select the items on a layer and accidentally move them.  

In this section, you will complete the following tasks: 

 Creating a new layer 
 Importing to a layer 

1. Select Layer 1 in the Timeline and click the dot below the lock icon, as shown in 

the following figure.  
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Lock a layer so its contents aren't accidently moved or deleted from the Stage. 

You can also prevent inadvertently adding other assets to that layer. 

With your only layer locked, you need to add new layers before you can add any 
other objects to the Stage. You cannot add new objects to a locked layer. 

2. Select the Selection tool in the Tools panel, and double-click the name Layer 1.  

When you double-click a layer name, you can modify the name of the layer. 

3. Type background into the layer name to rename the layer. Then save your file.  

When you start building projects with many layers, layer names like Layer 1 and 

Layer 14 don't help you determine what's on that layer. Giving layers a 
descriptive name is a good practice to adopt. 

4. Select File > Save before you proceed to the next exercise (Creating a new layer).  

Creating a new layer 

In just about any Flash project where you use imported graphics and animation, you'll 
need to create at least a few layers. You need to separate certain elements onto their own 
layers, particularly when you start to animate objects. You can also stack graphics on top 

of each other, and even create a sense of depth or overlapping by using multiple layers. 

1. Select the background layer on the Timeline, and click Insert Layer to create a 
new, empty layer.  

The new layer is created above the background layer (see the following figure). 

 

Click Insert Layer to insert a new layer above the currently selected layer. 

file:///F:/ProgramData/Macromedia/Flash%208/en/Configuration/HelpPanel/Help/Tutorials/00000125.html%23202955


               Odisha State Open University Page 92 

 

2. Double-click the name of the new layer so the layer's name becomes editable.  
3. Type animation to rename the new layer.  

Graphics on the Stage stack according to the layers on the Timeline. For example, 

anything that you put on the animation layer will appear above the image on the 
background layer. You will add animation to this second layer in Part 2 of this 

unit.  

4. Select File > Save before you proceed to the next exercise (Importing to a layer).  

Importing to a layer 

In an earlier exercise, importing graphics, you imported the gnome.png image directly 
into the document's library. Then you dragged the image onto a selected layer on the 

Stage. You can also import assets directly to the Stage instead of into the library. First 
you need to select the frame into which you want to import the image on the Timeline. 

Then you can import the image onto that frame, which displays on the Stage. You use 
this technique to import an image in the following exercise. 

1. Select frame 1 of the animation layer.  

You need to import star.png image to the animation layer.  

2. Select File > Import > Import to Stage.  

The Open dialog box appears where you can select an image from your hard disk. 

Find the folder of this unit's source files on your hard disk. 

3. Select star.png in the unit's source files, and click Open (Windows) or Import 
(Macintosh).  

The image imports to the animation layer (see the following figure), and then it 

appears on the Stage. 

 

The image imports to the frame on the layer that you select on the Timeline. You 
will learn more about the Timeline and layers in Part 2 of this tutorial, Basic 

Tasks: Creating a banner, Part 2. 

4. Open the Library panel (Window > Library).  
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The image you just imported to the Stage also appears as an asset in the library. 
Even if you import an asset directly to the Stage, Flash always stores the assets 

you import in the library as well. 

5. Click the Selection tool in the Tools panel.  

Move the star.png file on the Stage to just above the gnome's head in the image, 
as shown in the following figure. 

 

Move the star.png image just above the gnome's head. 

6. Select File > Save to save your document before moving on to Test the 
application.  

4.14 Summary  
 

 Flash - Flash is an animation software package. Flash provides a versatile and 

easy way to create animation. 

 Stage: This is the rectangular workspace area where we place our contents or 

create our drawing or movie. By default, the Stage size in flash is 550 x 400 

pixels. 

 Timeline: The Timeline is a fixed window that stays on top of every object in the 

workspace. This is the area where graphics and elements are assembled in 

sequential order allowing the user to view the order of events in sequence. 
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 TEXT TOOL- This tool is used to type on the screen. It allows you to add text in 

your drawing and animations. 

 ERASER TOOL- "This tool helps us to erase lines and fills of an object from the 

Stage 

 INK BOTTLE TOOL- It is used to change the stroke color, width and style of 

lines or shape outlines. 

 BRUSH TOOL - It can be used just like a brush on a canvas. You can paint a 

shape with the desired colour using the Brush Tool 

4.15Check your Progress 
 

1. What is the full form of fps? What will happen if the Frame rate is decreased from 12 to 
5 fps?  
_______________________________________________________________________ 

_______________________________________________________________________

_______________________________________________________________________ 

2. Write the difference between a guide layer and a mask layer.  
_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________ 

3. What is Layer? 

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________ 

4. Write the three different modes of pencil tool. 

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________ 

5. What is properties panel ? 

_________________________________________________________________

_________________________________________________________________

_________________________________________________________________ 
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4.16 Check your Progress-Possible Answer 
 

1. The full form of fps is frames per second. if the frames per second is decreased 

from 12 to 5 we will not be able to view the animation properly . 

2. A motion guide layer lets the designer draw paths along which tweened symbols 

can be animated whereas a mask layer is used to create a hole through which the 

contents of one or more underlying layers are visible.  

3. Layers are like multiple film strips stacked on top of one another, each containing 

a different image that appears on the stage. 

A layer contains its own time line with endless frames. It could be defined as one 

independent movie of only one level.  

4. The three different modes of pencil tool is Straighten, Smooth, and Ink. 

5. The Properties Panel is a combination of various elements used for changing the 

settings like the Stage size, the ruler unit, the background color of the Stage and 

the Frame rate. 
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